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Maya FBX plug-in What’s
New

The following section contains the new features and known limitations for this
version of the Autodesk Maya FBX plug-in.

NOTE

Consult the readme file for any last-minute changes to this release. Windows users
can find the readme, along with this Help system, in the Program Files > Autodesk
FBX folder. Macintosh users are offered the option to save the readme during the
installation process.

What'’s new in this version

This section lists the bug fixes associated with this version of the Maya FBX
plug-in.

"rootNode' Node problems

Nodes named "rootNode" now import correctly. Previously naming conflicts
prevented nodes with this name from being read by the FBX Importer.

MotionBuilder custom property import

Problems where the FBX plug-in did not import animation on MotionBuilder
custom properties have been resolved.



Tangents and Binormal Export

An issue with the export of normal/binormals on non-triangulated meshes
has been resolved.

NOTE There is a known limitation with tangents and binormals. See Tangents and
Binormals (page 126) in the Limitations (page 125) section.

Instability on Export

You can now export Maya files with the Referenced Containers Content (page
40) option disabled. Previously, this caused instability in Maya.

Lengthy import of large files

An issue where files with millions of polygons and multiple materials took a
long time to import into Maya has been resolved.

Conversion support

The following sections are about how the Maya FBX plug-in converts Maya
objects and their properties.

For a detailed report of conversion support for this version, see the Maya
Compatibility Chart. The FBX compatibility chart explains what is supported
and at what level, when you export from Autodesk Maya and import into
Autodesk 3ds Max, Autodesk Mudbox or Autodesk MotionBuilder.

File textures, procedural, and map channels

The Maya FBX plug-in supports texture files in almost any standard material
channel. Anything that you map in the Color, Bump mapping and other
channels translate to FBX, as long as they are not procedural maps.

Map channel Support
Color Supported
Transparency Supported

2 | Chapter1 Maya FBX plug-in What's New
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Map channel Support

Ambient color Supported
Incandescence Supported
Bump Supported
Diffuse Supported
Cosine power Supported
Specular color Supported
Reflectivity Supported
Reflected color Supported

The Maya FBX plug-in supports file texture maps. If you are using either 2D
or 3D procedural textures, convert them to a file texture first.

NOTE

The Maya FBX plug-in ignores any maps applied to unsupported channels on
export.

Camera support

The following tables indicate how both Maya and the FBX file format treat
cameras.
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Camera export

The following table lists Maya cameras and how the FBX file format treats

them on export:

In Maya

Becomes in FBX

Camera

Camera without interest.

Camera and Aim

Camera with interest.

Camera, Aim, and Up

Camera with interest and up vector.

Angle of View

Field of View FCurve. The view is consistent
even though the focal length values change
when you import the FBX file into 3ds Max.

Near/far clipping planes

Near and Far clipping plane values are sup-
ported but not animation.

Stereo Camera

StereoCamera

NOTE

Any animation applied to a Maya camera’s Up node is baked onto the camera’s
rotation when you import it into 3ds Max.

Custom camera export

When the Maya FBX plug-in exports custom cameras, the exporter sets the
Render Image Size and Pixel Aspect Ratio for all cameras. If no custom
cameras exist, the Render Image Size and Pixel Aspect Ratio values are

not exported.

NOTE

Make sure your custom camera is the current camera in the scene when
exporting to FBX for the correct transport of the camera Render image Size

and Pixel Aspect Ratio.

Maya FBX plug-in What’s New



Camera import

The following lists how Maya treats MotionBuilder cameras on import:

In FBX Becomes in Maya

Free Camera Camera

Camera (With a look-at Target/Interest) Camera and Aim

Orthographic Camera Camera with an orthographic setting.

Custom camera import

When the Maya FBX plug-in imports Maya and 3ds Max custom cameras, the
Render Image Size and Pixel Aspect Ratio applied to the scene is set by
the current camera. That is, the Render Image Size and Pixel Aspect
Ratio from additional cameras are ignored. If the current camera is not a
custom camera, the Render Image Size and Pixel Aspect Ratio values
are not imported.

Light support

The following tables list Maya lights and how the plug-in treats them when
they are exported to the FBX file format and imported into Maya:

Light types
In Maya When imported back into Maya
Ambient light Point light
Directional light Directional light
Spot light Spot light
Area light Point light
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In Maya

When imported back into Maya

Point light

Custom properties

Point light

Because of type limitations in FBX files, the following conversions are applied.

Exported from Maya

Becomes in FBX

Vector VECTOR
Boolean BOOL
Integer INTEGER
String STRING
Enum ENUM
Float REAL
Imported FBX Becomes in Maya
REAL Float
BOOL Boolean
INTEGER Integer
STRING String
VECTOR Vector

The Maya FBX plug-in supports Extra Attributes (or custom properties) applied

to Materials and Transform nodes.
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Level of Detail group nodes

The Maya FBX plug-in supports LOD (level of detail) group nodes. See the
Maya documentation on LOD group nodes for more information.

Joint Orients

The Maya FBX plug-in converts Maya Joint Orients to pre-rotation on export.
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Installing the Maya FBX
Plug-in

Maya uses the Maya FBX plug-in to import, export, and convert files using the FBX
file format. This chapter describes how to install the Maya FBX plug-in on Windows®,
Mac® OS X, and Linux systems.

The Maya FBX plug-in comes with Maya and is installed automatically. This procedure
is included so you can upgrade your Maya FBX plug-in with later versions.

NOTE

The Maya FBX Plug-in that accompanies your version of Maya may not be the most
recent version. It is a good practice to check for updates, as each subsequent Maya
FBX Plug-in version has enhanced functionality, and is available free. See Web updates
(page 27) for instructions on how to verify that your plug-in version is the latest.

IMPORTANT

Plug-ins run only on the version of Maya for which they are created; verify that the
version of the Maya FBX plug-in that you are installing is appropriate for the version
of Maya you are running.

The Maya FBX plug-in is available for Windows®, Mac® OS X, and Linux systems.

Windows installation

The Maya FBX plug-in is compatible with the following versions of Microsoft
Windows®:
m  Windows XP (32/64-bit)

m  Windows Vista (32/64-bit)
m  Windows 7 (32/64-bit)



To install the Maya FBX plug-in:

1 Exit Maya or deactivate fbxmaya.mll in Maya's Plug-in Manager before
installing.

NOTE

If you install the Maya FBX plug-in while the fbxmaya.mll driver is in
use, the installation cannot occur and an “Error opening file for writing”
message displays.

2 Download the install file from www.autodesk.com/fbx. See Downloading
the Maya FBX Plug-in (page 15) for information on downloading the
latest Maya FBX plug-in.

3 Double-click the install file to launch the Autodesk Maya FBX plug-in
installer.

4 Click I accept to accept the terms of the license agreement, and then
click Next.

Autodesk’

License agreement

Autodesk -
LICENSE AND SERVICES AGREEMENT
Autodesk® FBX® Plug-Ins

READ CAREFULLY: AUTODESK LICENSES THE SOFTWARE AMD
OTHER LICENSED MATERIALS OMLY OMN THE COMNDITION THAT
LICEMNSEE ACCEPTS ALL OF THE TERMS COMTAIMNED OR -
@ | accept

) | reject
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5 The next window shows the recommended installation location for the
plug-in. To specify another location, click Browse to launch the file
browser.

Autodesk’

FBX f

Setup will install Autodesk FEX Plug-in 2013.1 - Maya 2013 64-bit (EMU)
in the following folder. To install in a different folder, dick Browse and select
another folder, Click Mext to continue.,

Destination Folder

Space required: 24, 7MB
Space available: 377.4GE

< Back ][ Mext =

6 Click Next.

7 A dialog box appears asking if you want to view the read me file. Select
Yes or No.

NOTE

The readme is located in the Program Files > Autodesk FBX folder, along
with this Help system.

8 The Installation completed window appears. Click Close to exit the
installer.

The Maya FBX plug-in is now installed.

NOTE For information on deleting the plug-in, see Removing the plug-in (page
16).
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Macintosh installation

The Maya FBX plug-in is available for Mac OS X 10.6.

To install the Maya FBX plug-in:

1

Download the TGZ file from the Autodesk web site
(www.autodesk.com/fbx) to your desktop.

Double-click the TGZ file to extract the Installation disk image.

Double-click the package icon to start the installation. The Welcome
pane appears.

e no « Install FBX Plug-in 2013.1 for Maya 2013

Welcome to the FBX Plug-in 2013.1 for Maya 2013 Installer

@ Introduction

Read Me You will be guided through the steps necessary to

install this software.
License

Destination Selakt
nstallation Type
nstallation

M. Sumimary

Go Back (" Continue )

A

Click Continue to start the installation process. The Software License
Agreement pane appears.

Read the License Agreement and click Continue. A dialog box appears
asking if you accept the terms and continue with the installation.

Click Agree to accept. The Select a Destination pane appears. Select
the destination disk where you want to install the Maya FBX plug-in
and click Continue.

The Easy Install pane appears. Click Upgrade.

A dialog box appears asking you to enter your name and login password
to continue the installation.

12 | Chapter 2 Installing the Maya FBX Plug-in


http://www.autodesk.com/fbx

9

10
11

12

13

NOTE You must obtain administrator privileges to continue installation.

The installation begins. A progress bar indicates the time remaining of
the installation. When the progress reaches 100%, the Finish Up pane
appears.

|snNOo « Install FBX Plug-in 2013.1 for Maya 2013

The installation was completed successfully.

@ Introduction

© Read Me
© License /
© Destination Select

Blinsrallagohigype The installation was successful.

@ Installation

€ Summary k 5 The software was installed.

1

Go Back ( Close )

A

Click Close to exit the installation program.

Start Maya and navigate to Window > Settings/Preferences >
Plug-in Manager.

NOTE This installs the Maya FBX plug-in to the following directory:
<Macintosh
Drive>/Applications/Autodesk/maya<ver>/Maya.app/Contents/MacOS/plug-ins,
where <ver> is the version of Maya you have installed.

Activate the Loaded option for Fbxmaya.bundle in the Plug-in
Manager.

Activate the Fbxmaya.bundleAutoload option so Maya loads the Maya
FBX plug-in automatically at start-up.

NOTE The FBX readme file is available during the installation process. An
option to save the readme is offered at this time. This lets you save the
readme so that you can determine where to store it.
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NOTE For information on how to delete the plug-in, see Removing the plug-in
(page 16).

Linux installation

The Maya FBX plug-in is available for Linux.

Linux compatibility
The Maya FBX plug-in is compatible with the following versions of the Linux

Operating system:
m GCC 4.0.2 (32- and 64-bit)

To install the Maya FBX plug-in:
1 Download the installation file from the Autodesk web site
(www.autodesk.com/fbx).

2 Remove the old plug-in from the /usr/Autodesk/maya<ver>/bin/plug-ins/
(where <ver> is the version of Maya you have installed,) directory by
entering rm —f fbxmaya.so at the command prompt.

3 Type the following command to install the Maya FBX plug-in:

./fbx<ver> maya<ver> linux enu
(Where FBX<ver> is the version of the Maya FBX plug-in you have installed).
This installs the plug-in to the following directory:

[usr/Autodesk/maya<ver>/bin/plug-ins/ (where <ver> is the version of Maya
you have installed).

If you install Maya in another folder, you can specify the path on the
Command Line after: ./fbx<ver>_maya<ver>_linux_enu /home/maya/mypath/

(Where FBX<ver> is the version of the Maya FBX plug-in you have installed.)
1 Start Maya and navigate to Window > Settings/Preferences >
Plug-in Manager.
Activate the Loaded option for Fbxmaya.so in the Plug-in Manager.

Activate the Fbxmaya.soAutoload option so Maya loads the Maya FBX
plug-in automatically at start-up.
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NOTE For information on how to delete the plug-in, see Removing the plug-in
(page 16).

Downloading the Maya FBX plug-in

The Maya FBX plug-in is available for free download.

The Maya FBX Plug-in that accompanies your version of Maya may not be
the most recent version. It is a good practice to check for updates, as each
subsequent Maya FBX Plug-in version has enhanced functionality, and is
available free. See Web updates (page 27) for instructions on how to verify
that your plug-in version is the latest.

To download the Maya FBX plug-in:

1 Go to www.autodesk.com/fbx

2 Click the Download FBX Plug-ins and Tools link for the latest SDKs
and FBX plug-in releases.

3 Click the FBX Plug-ins, Converter, and QuickTime Viewer
Downloads link.

4 Fill out the form that appears and click Submit. This takes you to a page
where the plug-ins reside.

NOTE

The Maya FBX plug-ins are categorized by type, operating system, then
application version.

5 Click the FBX plug-in link to download the corresponding FBX installer.

NOTE

To find older versions of the Maya FBX plug-ins, click the Plug-in and
Converter Archives link at the bottom of the web page.

Checking your version number

Once you complete the installation, run the Maya FBX plug-in. When you
import and export, you can find the FBX version number in the Options >
Information.
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The Maya FBX plug-in that accompanies your version of Maya may not be
the most recent version. It is a good practice to check for updates, as each
subsequent Maya FBX plug-in version has enhanced functionality, and is
available free. See Web updates (page 27) for instructions on how to verify
that your plug-in version is the latest.

Edit Help
Presets
Current Preset:  Autodesk Media & Entertainment -
Include
Geometry

Animation

Lights

Embed Media

-
b
»
»  Cameras
b
»
2

Connections
»  Advanced Options

Information

FBX Plug-in version : 2013.1

About

Export

If your version is not the latest, you can update it for free. See Downloading
the Maya FBX Plug-in (page 15).

Removing the plug-in

When you install the Maya FBX plug-in, it installs two instances of the plug-in:
the actual FBX plug-in that is copied to the source directory (C:\Program
Files\Autodesk\Maya2013\bin\plug-ins) and a copy that is stored in the FBX
folder that you specified during the installation.
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Setup will install Autodesk FBX Plug-in 2013. 1 - Maya 2013 64-bit (ENU)
in the following folder. To install in & different folder, dick Browse and select
another folder. Click Mext to continue.

Destination Folder

Space reguired: 24, 7MB
Space available: 377.4GE

< Back ” Mext =

The installation screen that specifies a destination folder

When you uninstall the Maya FBX plug-in, the uninstall process only removes
the plug-in copy from the from the destination folder you specified during
the installation. To remove the FBX plug-in completely, you must delete it
manually. The reason you must perform a manual deletion is because the FBX
plug-in is a part of the default Maya installation.

Essentially, when you uninstall, you remove the contents of the FBX backup
folder, for example, C:\Program Files\Autodesk \FBX\FBXPlugins\2013.0\Maya
2013 64-bit, as well as any related entries in the Start menu.

It is good practice to keep the previous version of the plug-in, especially if you
are working on a project where the workflow is heavily dependent upon the
plug-in. If the newer version of the plug-in disrupts your process in some way,
you can revert to the previous version. If you do not want to lose access to
the FBX plug-in that ships with the Maya software, select Yes when asked if
you want to accept saving copies of the old plug-in. This option occurs
whenever you install newer versions of the FBX plug-ins.
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Removing the Maya FBX plug-in from Windows

To remove the Maya FBX plug-in manually:
1 In Maya, disable the fbxmaya.mll Loaded and Autoload options in
the Plug-in Manager.
Exit Maya.

Delete fbxmaya.mll from the Maya<ver>\bin\plugins directory, where
<ver> is the version of Maya you have installed.

Removing the Maya FBX plug-in from Mac OS X

To remove the Maya FBX plug-in:
1 In Maya, deactivate the fbxmaya.bundleLoaded and Autoload options
in the Plug-in Manager.
Exit Maya.

Locate the fbxmaya.bundle plug-in. This file resides in the <Macintosh
Drive>/Applications/Autodesk/maya<ver>/Maya.app/Contents/MacOS/plug-ins
directory, where <ver> is the version of Maya you have installed.

4 Delete the fbxmaya.bundle file.

Removing the Maya FBX plug-in from Linux

To remove the Maya FBX plug-in:

1 In Maya, deactivate the fbxmaya.soLoaded and Autoload options in
the Plug-in Manager.
Exit Maya.
Log into your system as root.
Remove the Maya FBX plug-in by entering the following command:

rm —-f /usr/Autodesk/maya<ver>/bin/plug-ins/fbxmaya.so
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FBX Plug-in Ul

This section describes the Maya FBX plug-in user interface which appears on the
right side of the Maya Import or Export dialog box under the General options
when you select the Maya Import and Export functions from the File menu.

The FBX options and menus are contained within rollout menus that you can expand
and collapse.

e« » + u HE

General Options
Reference Options
Include Options
File Type Spedific Options
Presets
ia & Entertainment
Include
Geometry
Animation

Cameras

Embed Media
Connections

Advanced Options

-
3
3
3
> Lights
3
3
3
-

Information
FBX Plug-in version : 2013.1
Help on FBX

Cancel

Maya Export All window A. FBX Exporter options
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Switching the FBX Ul

The Maya FBX plug-in is available to you in two ways: the OS Native U],
which shows the plug-in in a stand alone Importer or Exporter window, or
the Maya Default, which shows the plug-in as options within the Maya
Import or Export dialog boxes.

Two versions of the FBX Ul A. Maya Default B. OS native

Changing the Ul

To switch between the OS Native “classic”-look Ul and the Maya Default
U], select Window > Settings/Preferences > Preferences. In the
Preferences dialog box, locate Files/Projects and scroll down to the File
Dialog options.

You can also create your own presets. See Creating a custom preset (page 21).

Hiding the Ul

You can hide the plug-in when it is in the Maya Default setting if you drag
the center splitter bar to the right. This collapses the FBX Plug-in options.
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Creating a custom preset

You can design your own preset where you design the UI with options and
settings specific to you needs. You can then share this preset with others.

To create a custom preset

1 Select File and click the option box next to Import, Export All, or
Export Selection.
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The Options dialog box appears.
2 Select FBX export from the General Options File type menu.
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Edit Help

¥ General Options

¥ File Type Specific Op

File type menu

The Edit Preset button appears in the File Type Specific Options
rollout.

3 Click the Edit Preset button to show the Export/Import Options
dialog box.

Edit  Help

* General Options

File bvpe:
v Default file
v

Export unloaded references

*  File Type Specific Options

Edit preset option

4 The Ul of the Edit Preset dialog box is split into two sections, adding
a tree view of the FBX options in the left section.

Creating a custom preset | 23



5 Select, and then right-click elements in the Tree View to access the Edit
options. See Edit mode options (page 26)

% Edit export preset

Presets

NOTE

Some edit options are common to all structure levels, while some are
specific to a particular structure level. You can apply some options at
any level of the options structure. See Edit mode options (page 26).

Once you have finished, click Save preset.

7 The Saving new preset dialog box appears. Type the name of the new
preset for example, “MyNewPreset”.
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The new preset appears in the Maya FBX plug-in the next time you load
Maya.

The Maya FBX plug-in stores custom presets in a file so you can share them
with other users. You can find custom preset files in My
Documents\Maya\FbxPresets directory.

NOTE

Bake AnimationStart/End/Step values cannot be saved in presets. The
Maya FBX plug-in always derives these values from the exported scene. For
more see Preset Bake Animation settings (page 126)

Storing presets

You can save your custom presets in a file that you can share with other users.
Consult the table for the location of your saved presets.

Platform Preset location

Windows C:/Users/<username>/Docu-
ments/maya/FBX/Presets/<current plug-in
version>/import
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Platform Preset location

Macintosh /Users/<username>/Library/Prefer-
ences/Autodesk/maya/FBX/Presets/<current
plug-in version>/import

Linux /home/<username>/maya/FBX/Presets/<cur-
rent plug-in version>/import

NOTE

The table above shows the path for the import presets. Export presets follow the same
path but use “export” instead.

Preset files have the file extension .fbximportpreset (for import) and
fbxexportpreset (for export), for example, My Preset.fbximportpreset.

These presets are stored by user name so that multiple users can store custom
presets on the same machine.

You can also run the MELscript command to locate the FBX users preset path:

internalVar -userAppDir

Edit mode options

Use the Edit Mode options to customize your Maya FBX plug-in UI preset.

Show/Hide

Use this option to activate or disable the visibility of a group or option in the
UL

Enable/Disable

Use this option to lock the group or option so that it appears grayed-out in
the UI and cannot be modified.
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Expand/Collapse

Use this option to change whether the group or option is expanded (A) or
collapsed (B) by default in the Ul

¥ Presekts @

Current Preset:  Autodesk Media & Entertainment

P  Presets @

View as expandable group/View as expanded Panel

Use this option to set whether a group is expandable (A) or not (B).

¥ Presets 6

Zurrent Preset: | Autodesk Media & Entertainment =

Presekts @

Zurrent Preset: | Autodesk Media & Entertainment =

Web updates

Click the Web Updates button in the Information rollout to make sure
that you are using the latest version of the Maya FBX plug-in.

This function searches the Autodesk web site for a newer version of the plug-in
you are currently using.
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Edit Help

Presets
Current Preset: | Auto Media & Entertainment
Include
Geometry

Animation

Lights

Embed Media

-
»
2
»  Cameras
2
b
b

Connections
Advanced Options

Information

About

Export

If a newer version of the Maya FBX plug-in is available, a window appears to
inform you.

See Downloading the Maya FBX plug-in (page 15) for information on
downloading the latest Maya FBX plug-in.
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Help

Click the Help on FBX button in the Information rollout to access the
Maya FBX plug-in documentation.

Edit Help
Presets

a & Entertainment
Include

Geometry
Animation
Cameras
Lights
Embed Media

Connections

»  Advanced Options

¥ Information

FBX Plug-in version :

2013
Web Updates @ About

Export

NOTE The FBX Help documentation is available from a website, rather than installed

locally. To install the Help locally, the FBX help is available for download online at
www.autodesk.com/fbx-help.

About

Click the About button to view information about the Maya FBX plug-in.
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Edit Help

Presets
Current Preset:  Autodesk Media & Entertainment
Include
Geometry

Animation

Lights

Embed Media

-
3
»
» Cameras
3
3
3

Connections
»  Advanced Options

¥ Information

FBX Plug-in version : 2013.1
Web Updates Help on FBX o

Export

Export/Import or Close

At the bottom of the Maya Import or Export window, you can find
Export/Import and Close buttons.

Export/Import

Use the Export All, Export Selection, or Import button to start the export
or import process.
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Close

The Close button closes the Export or Import window without performing
any action.
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Export

This section contains information about options you can use in the Maya FBX
plug-inExporter window.

e » s & HE

General Options
Reference Options
Include Options
File Type Spedific Options
Presets
Current Presef ia & Entertainment
Include
Geometry

Animation

Lights

Embed Media

-
3
3
} Cameras
»
3
3

Connections
Advanced Options

Information
wversion: 2013.1

Help o

Fle name: ||

Files

Maya Export All dialog box A. FBX Export options

Exporting from Maya to an FBX file

To export your Maya scene:

1 Launch Maya.
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2 Select File > Export All, or File > Export Selection. The Export
All, or Export Selection dialog box appears.

3 Select FBX from File of Type menu.

NOTE

If you do not see the FBX file extension in the File of Type menu,
activate fbxmaya.mll in Maya's Plug-in Manager.

Enter a name for the FBX file you want to export.

5 The FBX Export options appear at the right of the Maya Export dialog
box.

6 Set the export options you want to use or select a preset from the Presets
menu. The Autodesk Media and Entertainment preset contains
the best balance of options for a general animation workflow. The
Autodesk MotionBuilder preset contains options set for character
animation using Maya and MotionBuilder.

Seelmport Presets Options (page 64) for more information about presets.
Edit Help

Presets
Current Preset: | Autod ia & Entertainment

Include

Geometry

Animation

Cameras

Lights

Embed Media

Connections

}  Advanced Options

Information

Export

7 Click Export in the Maya Export dialog box.
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NOTE To cancel the export process, press ESC.

8 1If conversions or errors occur during the export process, the Warning
Manager reports them at the end of the export process. See Show/Hide
Warning Manager (page 80) for information about the Warning
Manager.

NOTE

There is a difference between “Errors” vs. “Warnings”. The plug-in reports
an error when something unexpected occurs. When the plug-in reports
an error, it indicates that the consequences of that error are unknown.
Warnings inform users when the plug-in applies conversions to the
source data to convert the data into a format that the destination
application can read.

File Type Specific options

Export Preset Options

Presets The Maya FBX plug-in has two export workflow presets:

Autodesk Media & Entertainment preset The Autodesk Media and
Entertainment preset is the default preset for the Maya FBX plug-in
Exporter. The Autodesk Media and Entertainment preset contains the
optimal settings for most animation workflows.

Autodesk MotionBuilder preset The Autodesk MotionBuilder preset is
used for exporting animation files to MotionBuilder.Use the Autodesk
MotionBuilder preset if you are using a Maya to MotionBuilder back to
Maya workflow. This preset uses the Constraints (page 48) and Skeleton
defintions as (page 74) options set for optimal Character animation using
Maya and MotionBuilder.

Selecting a preset

Choose your preset by selecting it in the menu of the Maya FBX plug-in
Presets section.

File Type Specific options | 35



Edit Help

Presets
Current Preset: | Auto

Include
. User defined
Animation
Cameras
Lights
Embed Media

Connections

Advanced Options

Information

Export

Editing presets

If you change a preset, the preset field displays User defined, to show that
the preset differs from its default state. The plug-in saves the User defined
state in a temporary file so that the settings are the default the next time you
use the plug-in.

You can also use save your settings as a custom preset. See Creating a custom
preset (page 21).

Include

The Include rollout lets you decide what data and conversions the plug-in
applies to your scene at export from a host application.
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Edit Help

Presets
Current Preset: |Aut Media & Entertainment
Include
Geometry
Animation
Cameras
Lights
Embed Media

Connections

Advanced Options

Information

Export

Geometry

Smoothing Groups When you activate this option the Maya FBX plug-in
converts edge information to Smoothing Groups and exports them with
the file.

When this option is disabled, no edge information is converted to Smoothing
Groups.

NOTE The FBX Collada exporter does not export Smoothing Groups data from
3ds Max. Because of this, the FBX Collada importer will generate Smoothing
Groups during the import process.

Split per-vertex Normals Activate this option to split geometry vertex normals
based on edge continuity. Vertex normals determine the visual smoothing
between polygon faces. They reflect how Maya renders the polygons in smooth
shaded mode.

This option only applies to older MotionBuilder workflows to ensure visual
fidelity of surface continuity. It lets you transfer hard edge information to
MotionBuilder.
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This workflow is required because of limitation in MotionBuilder versions
2010 and earlier where there is no support ByPolygonVertex Normals.

Why would I use this?
This option lets you keep the same hard/soft edge look that you get from Maya
in MotionBuilder.

Do not use this option if you do not require hard edges in MotionBuilder,
since this operation duplicates vertex information and converts the geometry
itself. You can use the Combine per-vertex Normals option in the FBX
Importer to perform the inverse operation, but this may result in incorrect
UV texture maps, see the note that follows this entry.

If you are not using a merge-back workflow (merging FBX into existing scene)
using this option may result in incorrect UV mapping when reimporting the
FBX file into Maya. Import your FBX file into to your original Maya scene, to
avoid geometry UV issues with split geometry.

Exporting with the Split per-vertex Normals option disabled produces
the following result in MotionBuilder 2010 and earlier:

Exporting with the Split per-vertex Normals option activated produces
the following result in MotionBuilder:
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NOTE

Using this option alters UV maps applied to geometry permanently. The UVs
are then properly reassigned to the newly split geometry. When you import
this geometry into an empty Maya scene, there is a UV limitation where using
Combine per-vertex Normals in the FBX Importer might result in
incorrect UV assignments.

Tangents and Binormals Activate this option if you want the Maya FBX
plug-in to create tangents and binormals data from UV and Normal
information of meshes. This way you have a tangent space representation of
your meshes that you can use for advanced rendering.

NOTE

Your geometry must have UV information or the Maya FBX plug-in cannot
create tangents and binormals.

Why do I want to do this?

Exporting tangent and binormal data is useful when you define the local
coordinate system for each vertex in the mesh, which is referred to as “Tangent
space”. This is often required for advanced rendering techniques such as
normal mapping.

The Maya FBX plug-in reads the UV data and uses it to calculate the Tangent
space data for normal perturbation in per-pixel lighting.

NOTE There is a known limitation that affects this option. See Tangents and
Binormals (page 126) for more information.

Smooth Mesh The Smooth Mesh option lets you export source mesh with
Smooth mesh attributes. To export the source mesh, disable the Smooth mesh
Preview attribute in Maya, and then export.

If you activate the Smooth Mesh option, the mesh is not tessellated, and
the source is exported with Smooth Mesh data. If you disable the Smooth
Mesh option, the mesh is tessellated and exported without Smooth Mesh
data.

NOTE

If you export a Smooth Mesh Preview from Maya with the FBX Exporter
Smooth Mesh option disabled, it will not affect the mesh in the scene. Instead
your result is a tessellated mesh in the file, but with the original source mesh
unaffected/unchanged in the Maya scene.

Selection Sets The Selection Sets option lets you include or exclude
Selection Sets during the export process.
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Because including Selection Sets can potentially increase the file size, this
option is disabled by default, and the Selection Sets not are exported.

You must activate this option to export Selection Sets.

Convert to Null Objects Activate this option to convert all geometry into
locators (dummy objects) during the export process.

This option is often used for animation only files. It creates a smaller file size,
and is supported by FBX Importer when you import it into the original
scene.

In this case, the plug-in imports only animation onto original geometries,
and does not add incoming Nulls to the existing scene. If you import the same
file into a new scene, the plug-in imports Nulls with the animation applied.

Convert NURBS surface to This option lets you convert NURBS geometry
into a mesh geometry during the export process. This option is useful if you
are exporting a scene to a package that may not support NURBS.

By default, this option is set to “NURBS”, meaning the plug-in applies no
conversion and NURBS geometry is exported as NURBS.

Option Function

NURBS No conversion applied.

Interactive display mesh Converts geometry based on the NURBS
display settings.

Software Render Mesh Converts geometry based on the NURBS
render settings.

Preserve Instances Activate the Preserve Instances option to retain Maya
instances in the FBX export. If you disable this option, instances are converted
to objects.

NOTE

The Maya FBX plug-in does not support the duplication of input connections.
The use of Instances is supported but duplicating the inputs is not.

Referenced containers content Activate the Referenced containers
content option so that the content of referenced containers is not exported.
In other words, the containers are exported but their content is ignored.
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NOTE

You can only use the Referenced containers content option when you
export an FBX file. If you import this file back into Maya, the contents of your
containers are not imported.

Disable this option to export the content of referenced containers. Doing this
means that they are no longer references, but instead become objects in the
exported FBX file. This is the default behavior.

NOTE

This option has been added to the Maya FBX plug-in for use with Maya versions
2009 and later. For more information on Maya Containers, see the Maya
documentation.

Triangulate This option automatically tessellates exported polygon geometry.
NOTE This option affects Polygon Meshes, not NURBS.

Animation

Animation Activate this option to export animation found in the scene.

Expand this option to access advanced animation options and features. See
Animation (page 43).

Cameras

Cameras Activate this option to export all cameras contained in the scene.

The Maya FBX plug-in exports camera settings, but not render settings
associated to the camera with the file. This can change rendering results
depending on the source application used in comparison. For more information
on why this occurs, see Why are my cameras inconsistent? (page 122)

NOTE

When you export, Maya cameras are converted into FBX camera types for
interoperability.

Lights

Lights Activate this option to export all lights contained in the file. The Maya
FBX plug-in exports and converts light types to ensure FBX interoperability.

The Maya FBX plug-in supports Standard Point, Spot, and Directional
light types exported to FBX for Autodesk 3ds Max, Autodesk MotionBuilder,
and other Autodesk applications.
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Embed Media

Embed Media Activate this option to include (or embed) all media associated
with your scene in the FBX file itself. For example, texture images.

Activate the Embed Media option to make the Maya FBX plug-in include
(embed) associated media (textures, for example) within the FBX file, which
it then extracts to an .FBM folder at import. The Maya FBX plug-in copies
the embedded media to a <fileName>.fbm folder in the same location as the
FBX file and is named after the FBX file. Since this media is contained within
the FBX file itself, this has an impact on file size. Therefore, use this option
only when you transport an FBX file to a location where the original media
source is no longer accessible by the receiver.

NOTE

When you import an FBX file with embedded media, the embedded files
extract to a folder in the same location as the FBX file. If you do not have
write permission to create that new folder, the media files are Imported to the
user's temp folder, such as C:\Documents and Settings\<username>\Local
Settings\Temp.

If you disable the Embed Media option, the Maya FBX plug-in stores the
relative and absolute paths of the associated media files at export time. This
causes problems if, for some reason, the path is no longer accessible. Make
sure that the associated media is accessible to ensure the proper import of
these media files.

NOTE

If you export your file in ASCII format in FBX versions 2010 and earlier, no
textures are embedded. See Type (page 54).

Why do I want to do this?

Embed your media to ensure that all your textures are carried over and loaded
when you open the FBX file on another computer. You do not need to do this
if you are working on a local machine or over a network database that ensures
that the paths to media are not changing.

Connections

Input Connections This option causes the Maya FBX plug-in to export selected
objects without automatically exporting all related input connections. In
Maya, when you do an export selection to FBX, the Input Connections
option appears in the Maya FBX Exporter.
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If this option is disabled, no input connections associated with the selected
object are exported during the export selection operation. If the option is
active, however, all associated input connections to the selected object are
exported.

This option is active by default, so the Maya FBX plug-in includes any objects
that influence the selected ones.

Animation

Extra options

Use scene name Normally, the Maya FBX plug-in saves Maya scene animation
in the FBX file as Take 001. If you want the scene animation to instead be
named for the Maya scene, activate this option.

This option is deactivated by default, so the take is automatically named Take
001, and so on.

Remove single key When you activate this setting, the exporter removes keys
from objects on export if the plug-in determines that the animation has only
one key. When two or more keys exist in the file, the keys are exported.

If you disable this option, the plug-in does not remove keys from the animation
on export.

NOTE

This option is disabled by default.

Why do I need this?

Sometimes, even though objects in a file contain no animation, they have a
single key assigned to them for use as a locator. If you do not need these single
keys in your file, you can reduce the file size by activating Remove single
Keys to discard them.

Quaternion interpolation mode Use the Quaternion interpolation mode
menu to select how to export your quaternion interpolations from the host
application. Select from the following three options:

Resample as Euler interpolation This is the default conversion setting for
quaternion interpolations.

This option converts and resamples quaternion interpolations into Euler curves
to ensure interoperability.

Retain quaternion interpolation This option retains quaternion interpolation
types during the export process.
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NOTE

Use this option when you export animation that has quaternion interpolations.
This option is only compatible with applications supporting this interpolation
type, such as Autodesk MotionBuilder. Also note that the resulting animation
will not be identical since quaternion evaluations are different in Maya vs.
MotionBuilder. Use the default option (Resample as Euler interpolation)
to obtain visual results identical to your animation in MotionBuilder, or other
applications.

Set as Euler interpolation This option changes the interpolation type of
quaternion keys to a Euler type, without resampling the animation curves
themselves.

NOTE

Using this option results in the same number of keys, set as Euler types. The
visual result will be different since it is now evaluated as a Euler interpolation.
Use the default (Resample as Euler interpolation) option in order to
obtain visual results identical to your animation in MotionBuilder, or other
applications.

Bake animation

Activate this option lets you Bake (or Plot) Animation at export time.

Bake animation This bakes all unsupported constraints, including
Maya-supported and FBX constraints, into animation curves. You can then
import these curves into another application that does not support these Maya
constraints.

¥ Bake Animation

End: 4a

Step: 1

Resarmple Al

bake animation (export)exportbake animation

By default the Maya FBX plug-in takes the Start and End values automatically
from the current Timeline settings of the host application. You can manually
enter in a custom start, end, and step value to bake a specific section of time.
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NOTE

Bake AnimationStart/End/Step values cannot be saved in presets. The
FBX plug-in always derived these values from the exported scene. For more
see Preset Bake Animation settings (page 126).

Step The Step value defines how many keys are created per frame, and has a
value of 1 by default. Setting a Step value of 2 for example, only bakes and
exports a key every other frame.

Resample All Use the Resample All option to bake even the supported
animated elements. This is unlike the Bake Animation (page 44) option which
selectively bakes unsupported elements only.

NOTE

The Resample All option resamples animation using the host application’s
frame rate or Time setting.

The Resample All option reacts to the state of the Bake Animation option.
If Bake animation is activated, Resample All is also activated.

Why do I want to do this?

If you have animation in a scene that has a small section that contains
unsupported constraints or controllers, you can use this setting to customize
the Maya FBX plug-in export process to avoid resampling an entire scene
worth of animation data when only a small part of it is unsupported.

Deformed Models

Deformed Models Activate the Deformed Models option to export Skin
and Blend Shape deformations.

You can choose to export Skins and Bend Shapes specifically by expanding
Deformed Models to access individual options.

Blend Shapes Activate this option to export all geometry Blend Shapes used
in your scene.

Skins Activate this option to export all skin deformation into your scene.

Curve filters

Curve filters Activate Curve filtersto apply animation filters to function
curves during the export process.
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Constant Key Reducer

Activate the Constant Key Reducer filter to remove redundant keys.
Redundant keys are keys that have the same value, which are equivalent to
flat horizontal interpolations on a curve. Redundant keys are often a result of
a resampled FCurve before filtering.

Before:

In: Ve Seiect_Curems_Kiys Tengerts Ust Show e I

T EElN sA—=rEZVYANSNo 6 LN =GR EEED

Resampled FCurve before filtering

After:

s Tongerts Lk Show

[EE [ A= am|Z TV NN S0 S | 5 D

Filtered FCurve with redundant keys removed (based on Threshold setting)

You can set specific thresholds for each type of transform. Translation
Precision, Rotation Precision, Scaling Precision, and Other. Other
includes transforms like Blend Shapes and custom attribute curves.

The default values are:

¥ Curve Filters
Zurve Filkers o

¥ Constant Key Reducer

v fAuto bangents only
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Values represent generic units. This is why you may need to modify threshold
values in relation to the world scale of your scene, for example with very large
or small scale scenes.

If you use this filter to eliminate noise, for example, from motion capture
data, then you may need to modify values.

Setting Description

Translation Precision Threshold for translation curves in generic
units.

Rotation Precision Threshold for rotation curves in generic
units.

Scaling Precision Threshold for Scaling curves in generic
units.

Other Precision Threshold for other curves in generic units.

Auto tangents only This option ensures that only “auto” key
types are filtered. Otherwise, keys with in-
terpolation values greater than a certain
threshold may get deleted.

NOTE

The Maya FBX plug-in converts all animation keys to User, which is not an
Autoauto tangent. To ensure that constant key reducing occurs, deactivate
Auto Tangents Only in the Constant Key Reducer options.

Geometry cache file(s)
Geometry cache file(s) Activate this option to create a geometry cache file

of a chosen selection set. To use this option, create a selection set of the objects
for which you want to retain the vertex animation in Maya.

File Type Specific options | 47



NOTE

You must apply the set to the Objects Transform node and not the Shape
node. By default, any Geometry cache files created are in .MC format.
When you activate this option, three files are generated:

m an FBX file
m an XML file
m  an MC file

The Maya FBX plug-in stores the XML and MC files in a subfolder named after
the FBX file and has the suffix FPC (_fpc).

For example, if you export a scene containing a cube named pCubel to the
FBX file myTest.fbx, you create the following files and folders:

m  myTest.fbx

m  myTest_fpc

m  pCubeShapel.xml
m  pCubeShapel.mc

The plug-in retains any MC geometry cache files that are already recorded
(within the selection set).

Use the Set menu to select an appropriate set to export the geometry cache
file.

When would I use this?
Use this option when you export nCloth deformations on an object to 3ds
Max.

Constraints

Constraints Activate this option to ensure that certain supported constraints
are exported to FBX.

FBX supported constraints include:

m Point

= Aim

m Orient

m Parent
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m [K handle (including Pole Vector)

This option lets you export your constraints effectively without the need to
bake the animation first, if you are transferring to a package that which
supports these constraints, like MotionBuilder.

NOTE

If you export your scene with the intention of importing it into a package
that does not support these constraints (such as 3ds Max), bake the animation
first. See Bake Animation (page 44) for more information.

Skeleton definitions Activate this option to include your Skeleton
definitions (FBIK/HumanlIK) in the file on export. This can be useful if you
are transferring to MotionBuilder, which also supports characters.

Display Layers

NOTE

The export of display layers occurs automatically and does not appear as an
option in the Maya FBX plug-in user interface.

The Maya FBX plug-in automatically exports Display Layers found in your
Maya scene to FBX. This lets you transfer display layers from Autodesk Maya
to 3ds Max, and so on.

The following Maya Display layer properties are supported by the Maya FBX
plug-in:

m  Layer Membership List

m  Display Layer name

m  Level of Detail

m  Display types

= Visibility

m Color
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Advanced options

* Advanced Options

Unikts
Axis Conversion

uI

k
k
k
k

FBX. File Format

The Advanced Options section primarily contains additional options that
let you modify the default plug-in behavior. In most cases, you do not need
to modify these options to have a successful export. The section also holds
additional settings specific to the Collada file type.

Units

The Units option lets you view the conversion factor (scaling value) the
plug-in uses as well as modify the conversion units.

NOTE

This does not change the System unit settings in Maya.

Scale Factor Displays the conversion value or Scale Factor that the plug-in
applies to the entire scene during export.

By default, the Maya FBX plug-in uses the system units set in the host
application to determine what units to use to export the FBX file. This means
that the default export Scale Factor is always 1.0, and the plug-in applies
no unit scale conversion during the export process.

You can modify what units the Maya FBX plug-in uses to export your scene

if you change the File units converted to option. If you change the File

units converted to option, you modify the Scale Factor value and units
applied to the exported data.

Automatic option Activate the Automatic option if you want the Maya
FBX plug-in to automatically identify and set the units of the destination file
to match units of the host application

When you activate Automatic, the Scene units converted to option is
disabled, although it shows the resolved unit & Scale Factor. If you disable
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the Automatic option, the Scene units converted to option becomes
available.

When Automatic is active, the File Units will match the system units, and
the plug-in applies no conversion. The displayed Scale Factor is 1.0 in this
case.

File units converted to Use this menu to specify the units to which you want
to convert your exported scene. Modifying this setting directly affects the
Scale Factor value applied to the exported data.

The plug-in determines the default units by looking at the Maya System
Units option in the Window > Settings/Preferences > Preferences >
Settings category.

Edit  Help

Categories Settings: General Application Preferences

World Coordinate System

Lp
Working Units
Lingar: centimeter
Angular: degrees -
Time: =) -
current frames

Tolerance

Tangential: a0,

Cancel

In the FBX UI, the displayed Scale Factor uses the FBX Unit setting for its
calculation. The plug-in determines the FBX Unit setting from the host
application system units.

On export, the plug-in applies no default scaling since the export and system
units match. This results in a Scale factor of 1.0.
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NOTE

Verify the system units your Maya scene uses so that you can control whether
the plug-in needs to scale your scene. This way, it exports with the units you
want. Maya lets you change the System Units without affecting the scale of
your scene. Changing the system unit in Maya avoids scaling on export when
not required.

Example

If you export a file that is in the same Unit setting as the System Units of
your Maya scene, there is a match of units and the displayed Scale Factor
is 1.0. No scale conversion is applied.

¥ Units

Scale Factor: 1.0

Aubomatic

Axis conversion

The Maya FBX Exporter has two options for Axis Conversion in the Ul
Y-up, or Z-up.

¥ Axis Conversion

Up Axisi ¥

By default, the FBX Exporter always exports the Up Axis of the Host
application. For Maya, this means that all scenes are exported with a Y-up
world axis.

You can export your scene to a Z-up axis if the destination application does
not support the Y-up world axis and cannot convert the Y-up world axis of
your scene.

NOTE

The FBX Exporter applies Axis Conversions only to root elements of the
outgoing scene. If you have animation on a root object that must be converted
on export, these animation curves are resampled to apply the proper axis
conversion. To avoid resampling of these animation curves, make sure to add
a Root Node (dummy object) as a parent of the animated object in your scene,
before you export to FBX.
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Ul

These options let you set display options of the UI. This lets you show or hide
the Warning Manager and FBX UI windows.

You can customize these display options, save them as a new Preset, and share
this preset file. See the Creating a custom preset (page 21) section for more
information.

Show/Hide Warning Manager This option lets you disable the Warnings
and Errors dialog box that appears during the export process. The Warning
Manager is active by default.

What is the difference between an Error and a Warning?
The Maya FBX plug-in uses errors and warnings to alert you of conversions
and potential problems during the export process.

When something unexpected occurs during the conversion, the plug-in reports
an error. This error occurs when the plug-in encounters an unknown behavior
and the conversion is going to produce an unexpected result.

When the plug-in must apply a conversion to the source data for it to be in
a format that the destination application can read, the Maya FBX plug-in
reports a warning. This warning is not the indication of a problem, but instead
exists to provide a report of conversions that the plug-in has applied to the
incoming data.

Generate log data Deactivate the Generate log data option if you do not
want warning and error information written to the log. However, if you do
deactivate this option, the FBX Exporter/Importer does not write log data
(such as errors and warnings,) to the generated log file. However, the file name
and time stamp are still recorded in the log.

The Maya FBX plug-in stores log files with the FBX presets, in C:\My
Documents\Maya\FBX\Logs.

Why do I want to do this?
Occasionally, some batch imports/exports create very large warning/error files,
and in this case you might want to disable this option.

Normally, it is recommended to leave the Generate log data option active,
which is the default, as this helps you identify problems with file conversions.

Log files are important for tracking errors and warnings on export. It is not

recommended to deactivate this option when you export a series of files, for
example, in an automation or batch export because you will not receive any
feedback about any issues that concern files during export. This lack of feedback
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can make it difficult to identify problem files which, in turn, makes diagnosing
problems difficult.

Occasionally, some batch imports/exports create very large warning/error files,
and in this case you might want to disable this option.

TIP

Because log data is appended to the same log file, after a while the size of this
file become large. It is a good practice to delete the log file after a few exports,
or before processing batch export or import.

FBX file format

This section lets you determine what form you want your FBX file to take.

Type Save your FBX file as one of these two types, Binary or ASCII. While
binary is the normal format for FBX files, ASCII files give you a plain text
version of the file format, which lets you search the file for information
retrieval.

NOTE You cannot view ASCII FBX files in the FBX for QuickTime viewer. Instead,
save your FBX file as a binary file.

Mode Function

Binary Activate this option to save the FBX file in
the standard format.

AsCIl Activate this option to save the FBX file in
ASCII format.

NOTE

If you export your file to ASCII format in
FBX versions 2010 and earlier, you cannot
embed media.

FBX version Expand the FBX Version menu to select an FBX version.
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The following table lists the different versions available for you to select from
the FBX exporter.

Version Description

FBX 2013 Select this FBX version to export a file that
is compatible with Autodesk 2013 applica-
tions and 2013 FBX plug-ins. This is the
default FBX version.

FBX 2012 Select this FBX version to export a file that
is compatible with Autodesk 2012 applica-
tions and 2012 FBX plug-ins.

FBX 2011 Select this FBX version to export a file that
is compatible with Autodesk 2011 applica-
tions and 2011 FBX plug-ins.

FBX 2010 Select this FBX version to export a file that
is compatible with Autodesk 2010 applica-
tions, 2010 FBX plug-ins and MotionBuilder
2009..

FBX 2009 Select this FBX version to export a file that
is compatible with Autodesk 2009 applica-
tions and 2009 FBX plug-ins.

FBX 2006 Select this FBX version to export a file that
is compatible with Autodesk 2006 FBX plug-
ins and MotionBuilder 7.5, 7.0, and 6.0. .

When do I use this?

You do not need to change this option if you are using the latest FBX Plug-ins
in the source and destination applications. You only need to use this option
if you plan to import your file using an older plug-in version.

For example, if you want to export from Maya 2013 and import to Maya 2012
using the latest FBX 2013 versions of the plug-ins in both applications, you
do not need to change the export FBX version. The file is compatible when
you use the FBX 2013 versions of the plug-in.
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Information

Information
Edit Help
Presets
Current Preset: Autodesk Media & Entertainment =
* Include
Geometry
Animation
Cameras
Lights
Embed Media
Connections
»  Advanced Options

Information

FBX Plug-in version : 2013.1

felp on FBX About

Export

The Information rollout contains data about the Maya FBX plug-in as well as
buttons you can use to check for more recent versions of the software and
accessing the Maya FBX plug-in Help.

Web Updates

Click Web Updates to make sure that you are using the latest version of the
Maya FBX plug-in. This function searches the Autodesk web site to check if
there is a newer version of the plug-in that you are currently using. See Web
updates
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Help on FBX
Click Help on FBX to launch the Maya FBX plug-in online user
documentation.

NOTE The FBX Help documentation is available from a web site, rather than
installed locally. If you want to install the Help locally, you can download the FBX
help at www.autodesk.com/fbx-help.

About
Click About to display information about the version of the Maya FBX plug-in.

Collada

The Collada options only appear in the Ul when you select the DAE_FBX
file type from the file browser when you export.

NOTE

When you export in Collada format, textures are not embedded, even when
the Embed Textures option is activated. See Embed Media (page 42).
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Edit Help

Presets
Current Aut & Entertainment

¥ Include

»  Geometry

}  Animation
Cameras
Lights
Connections
Advanced Options
Units
Axis Conversion
UI
Collada
v Triangulate
v Single I

Frame Rate

Triangulate
This option automatically tessellates the exported polygon geometry.
Single matrix

This option ensures that there is only a single animation matrix for each
node/object by baking all animation matrices into one.
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Frame Rate

Use this field to set the frame rate of the scene on export.

NOTE
The Maya FBX plug-in now supports Lines and Linestrip nodes.
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Import

This chapter contains information about options you can use in the Maya FBX
plug-in Importer functions that appear to the right of the Maya Import window.

I} 0:'\_aAA_Computer Refresh\My Documents {copy)| -« » 4 u HE

General Options
Referencing Options
Namespace Options
File Type Specific Options
Presets
Entertainment

Statistics

Include
Advanced Options

Information

Maya Import dialog box A. FBX Import options

Importing FBX files into Maya

This section describes how to import files using the Maya FBX plug-in:
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To import an FBX file:

1 Launch Maya.

2 Select File > Import. The File Import dialog box appears. Locate the
FBX file you want to import.

3 Select FBX from the File of Type menu.
NOTE

If you do not see the FBX file extension in the File of Type menu,
activate fbxmaya.mll in Maya's Plug-in Manager.

I D:\ AaA_Computer Refrash\My Documents copy)l

General Options
Referencing Options
Hamespace Options
File Type Specific Options

Presets

Ttertainment

im
> Include
»  Advanced Options

»  Information

Maya Import dialog box A. FBX options

4 The FBX Import options appear at the right of the Maya Import dialog
box.
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Options...

¥ General Options

¥ Namespace Options

Import options

Set the import options you want to use or select a preset from the Presets
menu. The Autodesk Media and Entertainment preset contains
the best balance of options for a general animation workflow. Use the
Autodesk MotionBuilder preset if you are using a Maya to
MotionBuilder back to Maya workflow.

See Import presets (page 64) for more information about the Autodesk
presets and for information about import options and which are
appropriate for you, review the Import (page 61) section.

Click Import in the Maya Import dialog box.
NOTE To cancel the import process, press ESC.

If conversions or errors occur during the import process, the Warning
Manager reports them at the end of the import process. See Show/Hide
Warning Manager (page 80) for information about the Warning
Manager.
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NOTE

There is a difference between “Errors” vs. “Warnings”. The plug-in reports
an error when something unexpected occurs. When the plug-in reports
an error, it indicates that the consequences of that error are unknown.
Warnings inform users when the plug-in applies conversions to the
source data to convert the data into a format that the destination
application can read.

File type specific options

These settings concern what gets included with your file on import.

Import Preset Options

Presets The Maya FBX plug-in includes the following import workflow presets:
m Autodesk Media and Entertainment

m Autodesk MotionBuilder

Selecting a preset

Choose your preset by selecting it from the Current Preset menu in the File
Type Specific Options rollout of the Maya FBX plug-in.
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General Options
Referencing Options
Namespace Options
File Type Specific Options
Presets
Current Pr : User defined

}  Statistics

~* Advanced Options

b Units
b uI
»  Performance

}  Information

Current Preset menu

Autodesk MotionBuilder
d

Preset

Description

Autodesk Media and Entertainment

The Autodesk Media and Entertain-
ment preset contains the most options
since it contains the optimal settings for
most animation workflows. All available
options are visible in the Ul so you can ac-
cess and customize them.

Autodesk MotionBuilder

Use the Autodesk MotionBuilder preset
if you are using a Maya to MotionBuilder
back to Maya workflow. This preset uses
the Constraints and Skeleton Defini-
tions options set for optimal Character
animation using Maya and MotionBuilder.

User Defined

User Defined preset label displays
whenever you modify a setting that is differ-
ent from the preset default.
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Editing presets

If you change a preset, the preset field displays User defined, to show that
the preset differs from its default state. You can find the user-defined states
in a temporary file so that the settings are the default the next time you use
the plug-in.

You can also save your settings is a custom preset. See Creating a custom preset
(page 21).

Statistics

The Statistics window lets you view relevant meta information about the
incoming (FBX) file and system (application) settings. Information varies
depending on what is in the file.

NOTE

Sometimes statistics information is hidden below the window edge; use the
scroll bar to view it.

¥ Statistics

version 7.5 build Tue

File name Displays the name of the file.
File directoryDisplays the location of the file directory.
File version Displays the FBX file format version of the file.

File creator Displays the name and version of the application that created the
file.

File creation time Displays the date and time that the file was created.
File axis direction Displays the up-axis of the file.

File units Displays the unit of measurement in the file.
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System axis direction Displays what the up-axis is in the current application.
System units Displays the unit of measurement used in the current application.

FPS

Displays the frame rate used (frames per second) in the imported scene and

the application. If the frame rate is not one of the standard rates (24, 25, 30,
48, 50, 60, 100, 120 fps), it is not displayed. For example, an FBX file that uses
a frame rate of 8 frames per second does not display in the Importer statistics.

NOTE If the frame rate does not match between the FBX file and its host
application, a warning appears next to the System Frame Rate value. If the
frame rate is not a standard rate, the Importer displays the system frame rate but
no warning.

File content Displays the contents of the file.

Include

¥ Include

File conkent:  Add and update animation =

Adds new content and updates only animation on matching objects in the scene.

The Include rollout lets you decide what data and conversions to apply to
your scene at import from a host application.

File Content

Use the File content menu to select how to import the content of your file
into the host application. Select from the following three options:

Add This option adds the content of the FBX file to your scene.
If elements exist in the host application they are duplicated, so use this option
to add non-existing elements to your scene.

Update animation This option adds the content of the FBX file to your scene
but only updates existing animation; any objects in the file that are not already
in the scene are ignored.

Add and update animation This option adds new content and updates
animation from your file to matching objects in your scene.

For example, if there is animation on any object in the FBX file and the object
name is identical to an object in the destination application, that animation
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is replaced. If the object with the same name does not have animation, the
new animation is added

This is the default option for the Media & Entertainment and MotionBuilder
presets.

Geometry

Expand the Geometry rollout to access options related to importing geometry
into your scene.

Unlock Normals Activate this option to unlock geometry normals and force
Maya to re-compute the edge continuity.

NOTE

Normals are automatically unlocked for all deformed geometry imported into
Maya.

When you disable the Unlock Normals option, Maya imports the locked
geometry normals as they were represented by the application that generated
the FBX file.

NOTE

Locked normals can create shading issues for geometry if a deformer is applied
after import. Unlocking geometry normals resolves this.

Maya fully smooth or faceted geometry
If you activate the Unlock Normals option, the object imports with unlocked
normals.

If you then unlock the normals faceted edges may appear. This occurs when
importing from 3ds Max. If this happens, select the object in Maya and apply
the Maya soften edge function to smooth the object.

If you disable Unlock Normals, the object imports with the correct look
and the normals will be unlocked.

Maya combination of soft and hard edges

With the Unlock Normals option activated, the object imports correctly
with its normals locked. If you intend to deform this geometry you must to
unlock the normals, but if you do this the object becomes hard edged in Maya.

Re-import the FBX file with the Unlock Normals option activated to resolve
this issue.

If you disable the Unlock Normals options, the object imports correctly
with unlocked normals.
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Maya deformations
When you activate Unlock Normals, Deformed geometry always imports
unlocked. The unlock function does not apply in this case.

If you do not have the Unlock Normals option activated, deformed geometry
imports unlocked. The unlock function does not apply in this case.

Maya smooth mesh preview
If you activate Unlock Normals, objects imported with smooth meshes
import with unlocked normals

If you disable the Unlock Normals option, the normals of objects with
smooth meshes import locked.

Combine per-vertex Normals Activate this option to combine geometry
vertex Normals.

Common uses of this option include reverting the Split per-vertex Normals
option of the FBX Export window. For more information regarding this
workflow see Split per-vertex Normals (page 37).

When you use the Combine per-vertex Normals option in the FBX
Importer, the Maya FBX plug-in performs the inverse operation of the Split
per-vertex Normals option in the FBX Export window. This can result in
incorrect UV texture maps (see the note below).

If you are not using a merge-back workflow (merging FBX into an existing
scene) this option might result in incorrect UV mapping when you re-import
the FBX file into Maya. Import your FBX file into to your original Maya scene
to avoid geometry UV issues with split geometry.

NOTE

Using this option permanently alters any UV maps applied to geometry. The
plug-in properly re-assigns the UVs to the newly split geometry. There is a
limitation in regards to UVs, when importing this geometry into an empty
Maya scene, using the Combine per-vertex Normals option in the FBX
Importer, as it may result in incorrect UV assignments.

Animation

Activate this option to import animation found in the scene. See Animation
(page 70) for a description of the options.

Cameras

Activate this option to import all cameras contained in the file.
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The plug-in imports camera settings, but not render settings. This can change
rendering results depending on the source application used in comparison.
See Why are my cameras inconsistent? (page 122) for more about render settings
limitations.

The plug-in saves cameras as FBX types in the FBX file for interoperability.
This means they must convert into Maya camera types on import.

Lights
Activate this option to import all lights contained in the file. The Maya FBX
plug-in exports and converts light types to ensure FBX interoperability.

FBX supports Standard Point, Spot, and Directional light types from
Autodesk 3ds Max, Autodesk MotionBuilder, and other Autodesk applications.

Animation

Activate this option to import animation found in the scene.

Extra Options

Expand this section to view additional import options

Animation Take Displays the current animation take in the FBX file.
m If no animation take exists in the file, the field shows a No animation
message.

m [f several animation takes exist in the file, the currently selected take is
displayed in the field.

You can change the selected take of animation by selecting another take from
the menu. The Maya FBX plug-in lists all available takes of animation contained
in the file.

NOTE

You can only select and import a single take of animation at a time.

Fill Timeline Activate this option when you want to update the application
timeline by the animation range in the incoming FBX file. “Animation range”
refers to the first and last keys of animation contained in the file.

Bake Animation Layers When the Bake Animation Layers option is
active, the plug-in collapses all layers into the base layer. If you disable the
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Bake Animation Layers option, all the layers in the FBX file will be
imported.

Optical Markers Activate this option to convert optical markers contained
in the file into dummy objects on import.

If you disable this option, the import process ignores this data.

Optical markers normally come from motion capture data, as a cloud of
animated points or markers. The Maya FBX plug-in does not import the
animation as the data type is incompatible. However, the Maya FBX plug-in
converts optical data into a cloud of static null objects in Maya.

TIP

If your optical data originates from MotionBuilder, you can set the state of all
optical markers to Done in MotionBuilder which lets you import the
animation data as curves in Maya.

Why Do I Want to Do This?

This option is useful if you need to import optical data that is stored within

an FBX file. For example, if you wanted to send an FBX file containing optical
data that someone needs to use in Maya but they do not use MotionBuilder,
you can activate this option to use the FBX file format to store optical data.

Quaternion Interpolation Mode

Use this option to convert and resample quaternion interpolation into Euler
curves to ensure interoperability.

Resample as Euler interpolation This is the default conversion setting for
quaternion interpolations .
This option converts and resamples qua-
ternion interpolations into Euler curves to
ensure interoperability.
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Retain Quaternion Interpolation

Set as Euler Interpolation

This option retains quaternion interpolation
types during the import process.

TIP

Use this when you import animation that
has quaternion interpolations. This is
only compatible with applications sup-
porting this interpolation type, such as
Autodesk MotionBuilder. Also, the result-
ing animation is not identical since qua-
ternion evaluations are different in Maya
and MotionBuilder. Use the default (Res-
ample as Euler interpolation) option in
order to obtain visual results identical to
your animation in MotionBuilder, or
other applications.

This option lets you change the interpola-
tion type of quaternion keys to a Euler type,
without resampling the animation curves
themselves.

TIP

Using this option results in the same
number of keys, set as Euler types. The
visual result will be different since it will
now be evaluated as a Euler interpolation.
Use the default (Resample as Euler inter-
polation) option to obtain visual results
identical to your animation in Motion-
Builder, or other applications.

Protect Driven Keys Activate this option to prevent any incoming animation
from overwriting channels with driven keys. Maya has special driven keys
that link one attribute value to another object attribute. These keys are
exclusive to Maya and are not supported by FBX. When this option is active,
the Maya FBX plug-in prevents the disconnection or overwrite of attributes

that use driven keys.
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If the option is active, the driven keys are protected and no incoming
animation is applied to the driven channels.

If the option is not active, the driven keys are discarded and the incoming
animation is applied to the driven channels.

Deforming Elements to Joints Activate this option to convert deforming
elements into Maya joints. This option was originally provided because Maya
did not support locator elements (that is, transform nodes that are not joints,)
within a joint chain.

If this option is not active, all elements other than joints being used to deform
are converted to locators. See Cluster import (page 127) for information about
cluster problems.

Update Pivots from Nulls Activate this option only when you import older
(pre-MotionBuilder 5.5) FBX files that contain an animated joint hierarchy,
for example, an animated character.

This option lets you assign the rotation transformation of the null (or joints)
elements in the hierarchy that are used as pre- and post-rotation to the joint
orient and the rotate axis of the original node.

The pre-rotation and post-rotation nodes are then deleted. Older files created
with the Export Pre/Post Rotation as Nulls option are merged back to
the original Maya setup.

Geometry Cache File(s) Activate this option to import FBX-exported geometry
cache data during the FBX import process.

The Maya FBX plug-in generates three files when you export Geometry cache
files using FBX:

m  an FBX file
m  an XML file
m  an MC file

The plug-in stores XML and MC files in a subfolder named after the FBX file
and has the suffix FPC (_fpc).

For example, if you export a scene containing a cube named pCubel to the
FBX file myTest.fbx, you create the following files:

m  myTest.fbx

m  myTest_fpc

m  pCubeShapel.xml
m  pCubeShapel.mc
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Deformed Models

Activate the Deformed Models option to import Skin and Blend Shape
deformations.

You can choose to import Skins and Blend Shapes specifically by expanding
Deformed Models to access individual options. You also have the option
to Pre-normalize weights. Pre-normalizing weights normalizes the weight
assignment of skin deformations so that smooth skin weights add up to one.

Skins Activate this option to import all skin deformation into your scene.

Blend Shapes Activate this option to import all geometry Blend Shapes into
your scene.

Pre-Normalize Weights Activate this option to normalize weight assignment.

What is pre-Normalizing?

During the import process, the Maya FBX plug-in can pre-Normalize weights
to ensure that every vertex on a skinned mesh has a weight no less than a
total of 1.0. You can have many joints that influence a single vertex, however,
the percentage of each deforming joint always equals a sum total of 1.0.

Why do I want to do this?
Use this function if you import older FBX files that result in abnormal mesh
deformations.

Constraints
Activate this option to ensure that certain supported constraints contained
in the FBX file are imported into Maya.

If this option is not active, no supported constraints are imported.

FBX supported constraints include:

m Point

m Aim

m Orient

m Parent

m IK handle (including Pole Vector)

Skeleton Definitions as Select the Skeleton definition to include

(FBIK/HumanIK/None) in the file on export. This can be useful if you are
transferring to MotionBuilder, which also supports characters.
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Advanced options

¥ Advanced Options
¥  Units
Scale Factor: 1.0

Automatic

Show Warning Manager
Generate Log Daka

* Performance

= for bad polygons

Use the Advanced Options to customize your general settings and import
process.

Units

The Units option lets you view the conversion factor (scaling value) the
plug-in uses as well as modify the conversion units.

This option automatically identifies, sets, and converts units of the incoming
file to match units of the host application.

If this option is active, but the File Units match the system units, there is no
need for scale conversion and the plug-in applies no conversion. The displayed
Scale Factor is 1.0 in this case.

NOTE This conversion affects only incoming data. This conversion does not change
the settings in Maya.

Scale Factor Displays the conversion value or Scale Factor that the plug-in
applies to the entire incoming scene.

The Maya FBX plug-in compares the units used in the host application with
the units used in the file imported to determine the Scale Factor value. The
plug-in then proposes a unit conversion that matches the system units in the
host application. The displayed Scale Factor is the result of this calculation.
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For example, if you import a scene from software that used centimeters as the
working units to software that uses feet as units, the Scale Factor will be 2.54.

This option is always active, but if your File Units match the system units, the
plug-in does not apply a scale conversion. No conversion is applied. The
displayed Scale Factor is 1.0 in this case.

NOTE

If you change the File Units Converted to: option, you can modify the
Scale Factor value applied to incoming data.

Automatic Activate the Automatic option if you want the Maya FBX plug-in
to automatically identify, set, and convert units of the incoming file to match
units of the host application.

When you activate Automatic, the Scene units converted to option is
disabled, although it shows the resolved unit and scale factor. If you disable
the Automatic option, the Scene units converted to option becomes available.

When Automatic is active but the file units match the system units, there
is no need for scale conversion and the plug-in applies no conversion. The
displayed Scale Factor is 1.0 in this case.

NOTE This conversion affects only incoming data. This does not change the
settings in Maya.

File Units converted to Use this menu to specify the units to which you want
to convert the file. Modifying this setting directly affects the Scale Factor
value applied to the incoming data.

The Maya FBX plug-in looks at the Settings/Working Units in the
Preferences window of Maya.
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Edit Help

Categories Settings: General Application Preferences
Yorld Coordinate System
Lp
Yorking Units
Linear:
Angular:

Time:

Tolerance

The displayed Scale Factor uses this unit setting for its calculation.

This automatic behavior ensures that the plug-in respects units, and proper
scaling is applied by default.

NOTE

Verify the System Units your Maya scene uses so that you can control
whether the Maya FBX plug-in needs to scale your scene.

Example

If you import a file that is in the same unit setting as the Working Units of
your Maya scene, there is a match of units and the plug-in displays “1.0” as
the Scale Factor. No scale conversion is applied.
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P  Mame Clash Options

¥  File Type Specific Options
Presets
Current Preset: User defined

¥ Statistics

P Include

¥ Advanced Options
¥ Units
Scale Factor: 1.0

Bukornatic
File units converted to; | Centimekers
b UI

P Performance

If the units do not match and your Maya scene is empty and/or changing the
System Units is not a concern, change the Maya System Units to match
the File Units used in the incoming file before you start to import. This results
in a match of units, Scale Factor of “1.0”, and no scale conversion is applied.

For example, if you import a file that is in centimeters into a Maya scene set
to inches, it results in a Scale Factor of 0.3937008. In this case, the incoming
data is scaled down to match the scene's unit system.

NOTE

If the Scale Factor is 1.0, no scaling is applied. If the Scale Factor is greater
than 1.0, the incoming data is scaled up. If the factor is smaller than 1.0, the
incoming data is scaled down.
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Options...

} HNamespace Options

¥ File Type Specific Options

Presets

¥  Statistics

}  Include
¥ Advanced Options
¥  Units
Scale Factor: 0.3937008
Automatic

File unit: ¢ Inches
L) §

»  Performance

If, with the previous example, you do not want to change the System Units
of your Maya scene and do not want the plug-in to scale your incoming data,
you have another option:

Change the File Units Converted To option to match the File Units. This
results in a Scale Factor of “1.0”, and no scaling is applied, even though
units do not match between the file and the Maya System Units.
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P Name Clash Options

¥ File Type Specific Options
Presets
¢ User defined
¥ Statistics

File Uni

P Include

¥ Advanced Options

*  Units
Scale Factor: 1.0

Automatic
File units corerted bo: | Centimeters
P our

}  Performance

ul
These options let you set display options of the Ul This lets you show or hide
the Warning Manager.

You can customize these display options, save them as a new preset, and share
this preset file. See the Editing presets (page 66) section for more information.

Show/Hide Warning Manager This option lets you disable the Warnings
and Errors dialog box that appears during the import process. The Show
Warning Manager option is active by default.
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What is the difference between an Error and a Warning?
The Maya FBX plug-in uses errors and warnings to alert you of conversions
and potential problems during the import process.

When something unexpected occurs during the conversion, the plug-in reports
an error. This error occurs because the Maya FBX plug-in encounters an
unknown behavior and the conversion is going to produce an unexpected
result.

When the Maya FBX plug-in must apply a conversion to the source data for
it to be in a format that the destination application can read, a warning is
reported. This warning is not the indication of a problem, but instead exists
to provide a report of conversions that have been applied to the incoming
data.

Generate log data Deactivate the Generate log data option if you do not
want warning and error information written to the log. However, if you do
deactivate this option, the file name and time stamp are still recorded in the
log.

Why do I want to do this?
Normally, it is recommended to leave the Generate log data option active,
which is the default, as this helps you identify problems with file conversions.

Occasionally, some batch import/export create very large warning/error files,
and in this case you might want to disable this option.

Performance

The Performance options let you detect performance issues with your file.

Test meshes and remove bad polygons Activate this option when you want
to test your mesh objects for degenerate polygons, such as two-sided polygons,
single vertex polygons, and so on. The Maya FBX Plug-in will evaluate the
scene for any degenerate polygons and remove them from mesh.

AXis conversion

The FBX Importer does not have an Axis Conversion option in the UL
Only the FBX Export window has this option exposed in the Ul

This is because the Maya FBX plug-in calculates and applies the Axis
Conversion automatically upon import.
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What does the automatic conversion do?

The FBX Importer looks at the up-axis used in the host application. It then
compares this to the up-axis set in the incoming file. If both up-axes match,
the FBX Import window applies no conversion. If they do not match, the
importer applies a conversion to the imported data to match the host
application’s up-axis automatically.

NOTE

The importer applies Axis Conversions only to root elements of the incoming
scene. If you have animation on a root object that must be converted on
import, these animation curves are resampled to apply the proper axis
conversion.

Information

The information rollout contains information about the Maya FBX plug-in.

Web Updates Click the Web Updates button in the Information rollout
to make sure that you are using the latest version of the Maya FBX plug-in.

This function searches the Autodesk web site for a newer version of the plug-in
you are currently using.
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Edit Help

Presets
Current Preset: Autodesk Media & Entertainment
Include
Geometry

Animation

Lights

Embed Media

-
»
2
»  Cameras
2
b
b

Connections
Advanced Options

Information

About

Export

1is up to date!
or upd:
1, Build Mumbe

If a newer version of the Maya FBX plug-in is available, a window appears to
inform you.

See Downloading the Maya FBX plug-in (page 15) for information on
downloading the latest Maya FBX plug-in.

Help on FBX Click Help on FBX in the Information rollout to access the
Maya FBX plug-in documentation.
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Edit Help

Presets
Current & Entertainment -
Include
Geometry
Animation
Cameras
Lights
Embed Media

Connections

»  Advanced Options

¥ Information
FBX Plug-in version : 2013

Updates

Information rollout: Help button

About Click About for information about this version of the Maya FBX
plug-in.
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Maya FBX Plug-ins
Workflows

The following are some tips for certain workflows that will provide optimal results.

IFFFS

Importing and Exporting Cameras

You can either import a camera you created and edited in Action, or import
one from another 3D application. Once a camera is imported, you can edit its
parameters, change its animation, and then export it back to the application it
came from.

Flame Cameras

Flame supports the import and export of 3D data saved in the FBX 3D format.
The FBX standard format provides a means for exchanging 3D data for scene
compositions—such as cameras—between tools and packages developed by
different manufacturers.

To export a camera to FBX format:

1 In Flame, select the camera you want to export.

2 IIn the Object menu, select the Camera menu and click Export. The
Export Camera file browser appears

3 Make sure FBX is selected in the Export Type box.
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4 Select which elements of the FBX files you wish to export by clicking

the corresponding filter button.

Enable:

To:

Rotate Axis

Rotate the exported camera by -90° on the
X-axis so that it is compatible with the co-
ordinate system of the 3D application.

Export Axes

Export the animated axes present in the
Action scene.

Export Point Cloud

Export the 3D point cloud created by the
3D Tracker.

5 Navigate to the location where you want to export the camera animation.

6 Enter a name for your exported camera in the file field.

7 Click Save.

Renaming strategy

When the Maya FBX plug-in discovers objects or elements that have the same
name, a naming conflict occurs. The Maya FBX plug-in compensates for this
by renaming the elements on import or export. The same is true for any upper-

and lower-case conflicts.

When does this happen?

This occurs when, for example, you export an FBX scene from 3ds Max that
contains two objects named “Box01”. The result in Maya is that the first object
called “Box01”, and the second object, originally called “Box01” as well, is

now named “Box01_ncl1_1". This must happen because Maya does not support

objects with the same names.

The following is a description of what happens:
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Redundant names

When the Maya FBX plug-in finds multiple instances of the same name in
the scene, a symbolic code is used. The Maya FBX plug-in can read older files,
although it no longer writes them this way.

The new suffix is then: _ncl1_x (where x is the instance number).

Case conflicts

When the Maya FBX plug-in finds upper- and lower-case conflicts in the names
of objects or elements in the scene, a more complex suffix is used to keep track
of which character was/is upper- or lower-case so it can be converted back on
import/merge.

The following suffixes are used to indicate the case:

Situation Suffix
Indicates case _ncl2
To depict characters that were originally _UuIXXXX

upper case and have become lower case

To depict characters that were originally _luxxxx. (Where xxxx is a four-digit integer
lower case and have become upper case representing the character position in the
string (bit-wise). For example, _ul5 indicates
that the first and third characters in the
string have been changed from upper to
lower case. A suffix can be made of the
combination of _ul and _lu sub-suffixes.)

Single-step workflows

FBX technology drives the Autodesk single-step workflow.

Single-Step Workflow Texture Location

Textures in files that use the single-step workflow process are stored in the
following location (unless otherwise specified).

Maya Default:
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C:\Documents and Settings\<username>\My
Documents\maya\projects\default\images\myscene-files\ (Windows XP)

C:\Users\<username>\Documents\maya\projects\default\images\myscene-files\
(Vista)

C:\Users\<username>\My
Documents\maya\projects\default\images\myscene-files\ (Windows 7)

3ds Max Default:

C:\Documents and Settings\<username>\My
Documents\3dsMax\sceneassets\images\myscene.max-files\ (Windows XP)

C:\Users\<username>\Documents\3dsMax\sceneassets\images\myscene.max-files\
(Vista)

C:\Users\<username>\My
Documents\3dsMax\sceneassets\images\myscene.max-files\ (Windows 7)

NOTE Unnamed scenes produce an "untitled-files" folder. This untitled-files folder
is re-used and overwritten for each unnamed scene.
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Maya MEL Scripting

This section contains scripts required for scripting with Maya MEL commands.

All of the Maya FBX plug-in's MEL commands begin with the FBX prefix. When
error conditions are encountered, they will display error messages in the script editor
window. The MEL commands that are registered by the Maya FBX plug-in are listed
in the Plug-in Manager information dialog box.

NOTE

To use the following MEL commands, the Maya FBX plug-in must be installed on
your computer.

Hiding the Ul

If you are writing a script and want to prevent the FBX UI from appearing each
time a file is imported you can use a specific command:

FBXImport -file "c:/myfile.fbx";

This automatically suppresses the FBX UI on import.

Scripting commands

Use these script commands to list, query, or set FBX I/O Settings properties for
the Maya FBX plug-in, including properties created with a plug-in extension.
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NOTE

The scripting commands do not affect the settings in the FBX Export/Import
Presets window.

The FBXProperty command lets you use every option available in the FBX
plug-in user interface.

There is generally a scripting command that represents every option found
in the Maya FBX plug-in. However, if an option is added at the last moment
and there is not yet a corresponding scripting command for it, you can use
FBXProperty to access the new unscripted option.

Another use for the FBXProperty command is if no scripting command exists
for you to use for a specific scripting workflow. With FBXProperty, you can
still access the command.

NOTE

We recommend using the normal scripting command if one exists. But if a
command does not exist for an option, you can use the FBXProperty to reach

it.

Command Description

FBXProperties Use this command to list all import and ex-
port properties available. This command
returns the property path, type, and current
value. If the property is an Enum, it returns
every possible value.

FBXProperty ImportlincludeGrplLight- Use this command to set an import value

GrplLight -v true; to true.

FBXProperty ImportlincludeGrplLight- Use this command to query an import

GrplLight -q; value.

FBXProperty ExportlincludeGrplLight- Use this command to set an export value

GrplLight -v true; to true.

FBXProperty ExportlincludeGrplLight- Use this command to query an export value.

GrplLight -q;
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All script commands and paths in this section are case sensitive, so it is good
practice to copy and paste them so you can have the exact path for the IO
Settings when querying for a list of properties and their path.

NOTE

These script commands support only Integer, Double, Bool, and Enum
properties

FBXClose

Closes the FBX importer so that any FBX files launched with the FBXRead
command are unlocked.

When you use the FBXRead command, it opens and locks the FBX file. To
release the file, you must either call the FBXClose command, or use call
commands that open a new file, for example, FBXRead or FBXImporter, and
SO on.

FBXExport

FBXExport -f [filename] [-s];
Exports the specified file.

Add the -s flag if you want to change the export process so it exports the
selected objects instead of an “export all” operation.

For example:

FBXExport -f myfile.fbx -s

FBXExportAnimationOnly

FBXExportAnimationOnly -v [truelfalse];
FBXExportAnimationOnly -q;

Use this script to export only animation. See Animation (page 43) for more
information.
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FBXExportApplyConstantKeyReducer

FBXExportApplyConstantKeyReducer -v [truelfalse];
FBXExportApplyConstantKeyReducer-q;

This is the script equivalent of theConstant Key Reducer (page 46).
True

Filters FBX animation FCurves through a Constant Key Reducer. This
eliminates constant keys on a FCurve and helps to reduce the size of resampled
FCurves, especially Scale.

False

Setting this command to False ensures that the animation data is not filtered.

FBXExportAxisConversionMethod

FBXExportAxisConversionMethod [nonelconvertAnimationladdFbxRoot];
FBXExportAxisConversionMethod -q;

This command lets you set an export conversion method. See Axis conversion
(page 52) for more information.

None

No conversion takes place and the exported data is unatfected.

Convert animation

Recalculates all animation FCurves so their values reflect the new World
system.

Add FBX_Root node

Adds a transformation node to the top of the scene to contain the
transformations needed to transport the data into the new World system. This
option facilitates backward compatibility as it generates the FBX file the same
way as earlier releases of the plug-in.
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NOTE

If the plug-in does not detect a need for the conversion, no Fbx_Root node is
added.

FBXExportBakeComplexAnimation

FBXExportBakeComplexAnimation -v [truelfalse];
FBXExportBakeComplexAnimation -q;

This command is the script equivalent of the Bake animation option. See
Bake Animation (page 44).

FBXExportBakeComplexEnd

FBXExportBakeComplexEnd -v [int];
FBXExportBakeComplexEnd -q;

This command is the script equivalent of the End field in the Bake
animation option. The passed value is an integer number. See Bake Anima-
tion (page 44) for more information.

FBXExportBakeComplexStart

FBXExportBakeComplexStart -v [int];
FBXExportBakeComplexStart -q;

This command is the script equivalent of the Start field in the Bake
animation option. The passed value is an integer number. See Bake Anima-
tion (page 44) for more information.

FBXExportBakeComplexStep

FBXExportBakeComplexStep -v [int];
FBXExportBakeComplexStep -q;
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This command is the script equivalent of the Step field in the Bake
animation option. The passed value is an integer number. See Bake Anima-
tion (page 44) for more information.

FBXExportBakeResampleAnimation

FBXExportBakeResampleAll -v [truelfalse];
FBXExportBakeResampleAnimation - q;

This command is the script version of the Resample Animation option in the
FBX Exporter. See Resample All (page 45).

FBXExportCacheFile

FBXExportCacheFile -v [truelfalse];
FBXExportCacheFile -q;

This command is the script version of the Geometry Cache file(s) option
in the FBX Exporter. See Geometry Cache File(s) (page 47).

NOTE

You must apply the set to the Objects Transform node and not the Shape
node.

FBXExportCameras

FBXExportCameras -v [truelfalse];
FBXExportCameras -q;

Use this function to either include or exclude cameras in your FBX export.
See Cameras (page 41) for more information.

FBXExportColladaFrameRate

FBXExportColladaFrameRate [float];
FBXExportColladaFrameRate -q;
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This function is the script equivalent of the Collada option.

FBXExportColladaSingleMatrix

FBXExportColladaSingleMatrix [truelfalse];
FBXExportColladaSingleMatrix -q;

This command is the script equivalent of the Collada Single matrix (page 58)
option.

FBXExportColladaTriangulate

FBXExportColladaTriangulate [truelfalse];
FBXExportColladaTriangulate - q;

This command is the script equivalent of the Collada Triangulate (page 58)
option

FBXExportConstraints

FBXExportConstraints -v [truelfalse];
FBXExportConstraints -q;

Causes all the constraints defined in the Maya scene to be either included or
excluded from the exported FBX file. See Constraints (page 48).

FBXExportConvertUnitString

FBXExportConvertUnitString [mm|dmlcm|imlkmlInlftlydimi];

This command returns the Scale Factor required to convert one centimeter to
the specified unit and is the script version of the File Units Converted To
menu in the FBX Exporter and Importer windows. SeeScene units converted
to (page 51) for more information.
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FBXExportDxfTriangulate

FBXExportDxfTriangulate [truelfalse];
FBXExportDxfTriangulate -q;

NOTE

This command is for the Macintosh and Linux platforms only.

FBXExportDxfDeformation

FBXExportDxfDeformation [truelfalse];

FBXExportDxfDeformation - q;

NOTE

This command is for the Macintosh and Linux platforms only.

FBXExportEmbeddedTextures

FBXExportEmbeddedTextures -v [truelfalse];
FBXExportEmbeddedTextures -q;

True

Saves all textures in the FBX file. This command performs the same action as
the Embed Media option in the FBX Exporter window. See Embed Media

(page 42).

FBXExportFileVersion

FBXExportFileVersion [version];

Where [version] is the following:
= FBX201300

m FBX201200
= FBX201100
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= FBX201000
= FBX200900
m FBX200611

See FBX Version (page 54) for more.

FBXExportGeneratelLog

FBXExportGenerateLog -v [truelfalse];
FBXExportGenerateLog -q;

Use this command to generate a log file on export. See Generate log data (page
53) for more information.

FBXExportHardEdges

FBXExportHardEdges -v [truelfalse];
FBXExportHardEdges -q;

Duplicates all vertices in the scene's meshes for each polygon connected to
them. The vertices’ normals are set accordingly, depending on whether they
are connected to a hard or smooth edge.

NOTE

This function allows MotionBuilder to display hard edges.

If two vertices are located exactly at the same position, a warning is issued, as
this causes unpredictable results when FBXImportHardEdges is set to True.

This command is the script version of the Split per Vertex Normals option
in the FBX Exporter. See Include (page 37).

FBXExportinAscii

FBXExportlnAscii -v [truelfalse];
FBXExportInAscii -q;
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Use this function to export as an ASCII file. See Type (page 54) for more
information.

FBXExportinputConnections

FBXExportInputConnections -v [truelfalse];
FBXExportInputConnections -q;

Use this function to query the current value of the input connection option.
The function returns O for False, and 1 for True.

Use this function with the FBXExport -f [filename][s] (page 91) script if you
are performing an export of selected objects. Set False so that the input
connections to selected objects are not considered during export. The default
value for this command is True, which makes the plug-in include all the objects
that influence the selected ones.

This is the script equivalent of the Connections (page 42) option in the UL

NOTE

This command is ignored during the “Export All” process.

FBXExportinstances

FBXExportInstances -v [truelfalse];
FBXExportInstances -q;

This is the script equivalent of the Preserve Instances (page 40) option in the
UL

FBXExportLights

FBXExportLights -v [truelfalse];
FBXExportLights -q;

Use this function to either exclude or include lights in the exported FBX file.
See Lights (page 41) for more information.
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NOTE

This option is activated by default.

FBXExportQuaternion

FBXExportQuaternion -v [quaternionleulerlresample];
FBXExportQuaternion -q;

Use the quaternion interpolation script to select how to export your quaternion
interpolations from the host application.

FBXExportQuickSelectSetAsCache

FBXExportQuickSelectSetAsCache —v “setName”;
FBXExportQuickSelectSetAsCache -q;

This command stores the setName as the set to be used when exporting the
cache file.

This command does not validate the received string. However, if the string
used here does not correspond to an existing (and valid) set in the Maya scene,
the cache export fails.

FBXExportReferencedContainersContent

FBXExportReferencedContainersContent -v [truelfalse];
FBXExportReferencedContainersContent -q;

This command is the script version of the Referenced Containers Content
option in the FBX Exporter. See Referenced Containers Content (page 40)

FBXExportScaleFactor

FBXExportScaleFactor [float];
FBXExportScaleFactor -q;
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This command is the script version of the Scale Factor field in the FBX
Exporter. See Scale Factor (page 50) for more information.

FBXExportShapes

FBXExportShapes -v [truelfalse];
FBXExportShapes -q;

Use this function to either exclude or include shape deformations with your
FBX file. See Deformed Models (page 45) for more information.

NOTE

This option is on by default.

FBXExportSkeleton

FBXExportSkeleton -v [truelfalse];
FBXExportSkeleton -q;

Use this function to either include or exclude Skeleton definition in your
export.

NOTE This command is the same as the deprecated FBXImportCharacter
command.

FBXExportSkins

FBXExportSkins -v [truelfalse];
FBXExportSkins -q;

Use this function to either exclude or include skin deformations in your FBX
file. See Deformed Models (page 45) for more information.

NOTE

This option is on by default.
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FBXExportSmoothingGroups

FBXExportSmoothingGroups -v truelfalse;
FBXExportSmoothingGroups -q;

This command is the script version of the Smoothing Groups option in the
FBX Exporter. See Smoothing Groups (page 37) for more information.

FBXExportSmoothMesh

FBXExportSmoothMesh -v truelfalse;
FBXExportSmoothMesh -q;

Use this function to export the subdivision level of the mesh.

FBXExportSplitAnimationintoTakes

FBXExportSplitAnimationIntoTakes -q
FBXExportSplitAnimationIntoTakes -c
FBXExportSplitAnimationIntoTakes -v

This command lets you export an ainmation file into multiple takes.

FBXExportSplitAnimationintoTakes -v

The FBXExportSplitAnimationIntoTakes -v option requires extra arguments.

Its syntax is: FBXExportSplitAnimationIntoTakes -v "takename" frameStart frameEnd
This sets the form "takename frameStart frameEnd" in memory. Subsequent

calls to the function append new entries in the table.

For example:

m  FBXExportSplitAnimationIntoTakes -v \"toto\" 1 5

m  FBXExportSplitAnimationIntoTakes -v \"tata\" 10 25
m  FBXExportSplitAnimationIntoTakes -v \"titi\" 3 20

Internally, frames are expressed in seconds. The conversion from frame to

seconds is performed using the current application framerate. After definitions
are available, calling FBXExportSplitAnimationIntoTakes -q. This returns:
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// Result: name=toto start=1 end=5 name=toto start=10 end=25
name=toto start=3 end=20 //

NOTE

m  The accumulator is not automatically cleared, if new definitions need to
be set for a second export; the caller is responsible for clearing the
accumulator by calling the command using the -clear option.

m  Take0O1 always exists regardless of how many splits are defined.
m  Setting a frameEnd < frameStart returns an error.

m frameStart and frameEnd do not necessarly define an interval with keys
and the split function does not try to validate. If no animation keys are in
the range, the take will still be created with no keys.

FBXExportUpAxis

FBXExportUpAxis [ylz];
FBXExportUpAxis -q;

This command lets you define the up axis in your FBX file. The up axis is the
global axis that points upwards. See Axis conversion (page 52) for more
information.

By default, the up axis in Maya is the Y axis.

Y

Sets the up axis to Y-up. This setting is the default.

y4

Sets the up axis to Z-up.

FBXExportUseSceneName

FBXExportUseSceneName -v [truelfalse];

FBXExportUseSceneName -q;
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This command is the script version of the Use scene name (page 43) option
in the FBX Exporter.

FBXExportTangents

FBXExportTangents -v [truelfalse];
FBXExportTangents -q;

This command is the script version of the Tangents and Binormals (page 39)
option in the FBX Exporter.

FBXExportTriangulate

FBXExportTriangulate -v [truelfalse];
FBXExportTriangulate -q;

This command is the script version of the Triangulate (page 41) option in the
FBX Exporter.

FBXImport

FBXImport -f [filename] -t [take index];
Imports the file specified in [filename] and the take specified in [take index].

The file imported is the one accessible for take querying after the execution
of the command.

Specify the appropriate take number to load the corresponding take. If you
specify O, the plug-in imports no animation. (This is the same as if you select
No Animation from the menu in the Maya FBX plug-in user interface.)

If you specify -1, the plug-in retrieves the last take in the take array. The plug-in
considers any number of takes greater than the amount of takes contained in
the file or any negative value less than -1 to be invalid. If this occurs, a No
such take error displays.

NOTE Do not open FBX files with the Python File(...) command. Instead, use the
FBXImport(...) command.
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FBXImportAxisConversionEnable

FBXImportAxisConversionEnable -v [truelfalse];
FBXImportAxisConversionEnable -q;

This command is the script version of the Axis conversion option in the
FBX Importer. See Axis conversion (page 81) for more information.

FBXImportCacheFile

FBXImportCacheFile -v [truelfalse];
FBXImportCachekFile -q;

This command is the script version of the Import geometry Cache file(s)
option in the FBX Importer. See Geometry cache file(s) (page 73) for more
information.

FBXImportCameras

FBXImportCameras -v [truelfalse];
FBXImportCameras -q;

Use this script to either import or exclude cameras with your FBX file. See
Cameras (page 69) for more information.

NOTE

This function is on by default

FBXImportConstraints

FBXImportConstraints -v [truelfalse];
FBXImportConstraints -q;

Causes all constraints defined in the FBX file to be ignored by the importing
process and excluded from the Maya scene. See Constraints (page 74) for more
information.
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FBXImportConvertDeformingNullsTojoint

FBXImportConvertDeformingNullsToJoint -v [truelfalse];
FBXImportConvertDeformingNullsToJoint -q;

Converts deforming elements into Maya joints.

True

Transforms all deforming elements into joint nodes.

NOTE

This option was originally provided because Maya did not support locator
elements (that is, transform nodes that are not joints,) within a bone hierarchy.
While Maya now supports this, in some cases this option improves the skinning
behavior.

See Deforming elements to joints (page 73) for more information.

FBXImportConvertUnitString

FBXImportConvertUnitString [mmldmlcmImlkmlInlftlydimi];

This command returns the Scale Factor required to convert one centimeter to
the specified unit and is the script version of the File Units Converted To
menu in the FBX Exporter and Importer windows. See File units converted to
(page 76) for more information.

FBXImportDxfWeldVertice

FBXImportDxfWeldVertice [truelfalse];
FBXImportDxfWeldVertice -q;

NOTE

This command is for the Macintosh and Linux platforms only.
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FBXImportDxfReferenceNode

FBXImportDxfReferenceNode [truelfalse];
FBXImportDxfReferenceNode -q;

NOTE

This command is for the Macintosh and Linux platforms only.

FBXImportDxfObjectDerivation

FBXImportDxfObjectDerivation [layerlentitylblock];
FBXImportDxfObjectDerivation -q;

NOTE

This command is for the Macintosh and Linux platforms only.

FBXImportFillTimeline

FBXImportFillTimeline -v [truelfalse];
FBXImportFillTimeline -q;

Fills the scene timeline on import (instead of using the Maya default).

FBXImportGeneratelLog

FBXImportGenerateLog -v [truelfalse];
FBXImportGenerateLog -q;

Use this command to generate a log file on export. See Generate Log Data
(page 81) for more information.

FBXImportHardEdges

FBXImportHardEdges -v [truelfalse];
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FBXImportHardEdges -q;

Merges back all vertices located at the same exact position as a unique vertex.
The Maya FBX plug-in then determines if the edges connected to each vertex
are hard edges or smooth edges, based on their normals.

Use this function when FBXExportHardEdges is set to True on export.

This command is the script version of the Combine per-vertex Normals
option in the FBX Importer. See Combine per-vertex Normals (page 38) for
more information.

FBXImportLights

FBXImportLights -v [truelfalse];
FBXImportLights -q;

Use this function to either include or exclude lights from the import process.
See Lights (page 70) for more information.

FBXImportMergeBackNullPivots

FBXImportMergeBackNullPivots -v [truelfalse];
FBXImportMergeBackNullPivots -q;

True

Assigns the rotation transformation of the null (or joints) elements in the
hierarchy that are used as pre-rotation and post- rotation to the joint orient
and the rotate axis of the original node.

The pre-rotation and post-rotation nodes are then deleted.

The look-up is done by name as the pre-rotation node's name contains the
“__Pre_ “suffix, while the post-rotation node's name has a “__Post_" suffix.

NOTE

When the import mode is set to Update animation or Add and Update
animation this option is automatically set to True.
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FBXImportMergeAnimationLayers

FBXImportMergeAnimationLayers -v [truelfalse];
FBXImportMergeAnimationLayers -q;

Activate Bake animation layers to bake (or Plot) animation layers contained
in the incoming file.

FBXImportMode

FBXImportMode -v [exmergeladdimerge;]
FBXImportMode -q;

This command has three possible states:

Exmerge

Merges the imported FBX file to the current scene in the following way:

Nodes of the same name and nature have only their animation curve replaced.
No new nodes are created. This command is the same as the Update
animation option in the plug-in Ul

Add

Adds the content to the current scene content. This command is the same as
the Add option in the plug-in UL

Merge

Merges the imported FBX file to the current scene in the following way: any
node without its equivalent in the scene is created. Nodes with the same name
but not of the same nature, for example, sphere and bone, are replaced. Nodes
with the same name and nature only have their animation replaced. This
command is the same as the Add and Update animation in the Ul

NOTE To view these in the Ul, see File Content (page 67).
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FBXImportProtectDrivenKeys

FBXImportProtectDrivenKeys -v [truelfalse];
FBXImportProtectDrivenKeys -q;

Use this script to prevent any incoming animation from overwriting channels
with driven keys.

If set to True, the driven keys are protected and no incoming animation is
applied to the driven channels.

If set to False, the driven keys are discarded and the incoming animation is
applied to the driven channels. See Protect Driven Keys (page 72) for more
information.

FBXImportQuaternion

FBXImportQuaternion -v [quaternionleulerlresample] ;
FBXImportQuaternion -q;

Lets you specify how quaternion rotations should be treated on import into
Maya. This option compensates for differences between Maya and
MotionBuilder quaternions. This command is the equivalent of the Quaternion
interpolation mode settings. See Quaternoin interpolation mode (page 71)
for more information.

FBXImportResamplingRateSource

FBXImportResamplingRateSource -v [MayalFBXI|Custom];
FBXImportResamplingRateSource -q;

This command lets you set the rate that the FBX Importer uses to produce
keyframes when it needs to resample data.

Resampling is used when the interpolation of the Maya animation curve
cannot be accurately represented by curves in MotionBuilder.
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FBXImportScaleFactorEnable

FBXImportScaleFactorEnable [truelfalse];
FBXImportScaleFactorEnable -q;

This command is the script version of the Scale Factor option of the FBX
Importer. See Scale factor (page 75) for more information.

FBXImportScaleFactor

FBXImportScaleFactor [float];
FBXImportScaleFactor -q;

This command is the script version of the Scale Factor menu in the FBX
Importer. See Scale factor (page 75) for more information.

FBXImportSetMayaFrameRate

FBXImportSetMayaFrameRate -v [truelfalse];
FBXImportSetMayaFrameRate -q;

This command lets you import the frame rate from the FBX file. This overwrites
the rate used in Maya.

FBXImportSetLockedAttribute

FBXImportSetLockedAttribute -v [truelfalse];
FBXImportSetLockedAttribute -q;

This command is the scripting equivalent of the UI dialog box Keep all
locked or unlock all options. Use this command when you import an FBX
file that contains animation onto an object that has locked channels.

When you use the Ul, the Maya FBX plug-in prompts you to either keep all
the channels locked or unlock the locked channels, which imports the
animation correctly. This had created problems for users who tried to do this
without working in the UL
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False

Unlocks all channels.

True

Channels remain locked.

Example code

FBXImportSetLockedAttribute -v False;

FBXImport -f "C:/myFile.fbx";

FBXImportShapes

FBXImportShapes -v [truelfalse];
FBXImportShapes -q;

Use this script to import or exclude shapes from your FBX file. See Deformed
models (page 74) for more information.

FBXImportSkeletonType

FBXImportSkeletonType -v [nonelfbiklhumanik];
FBXImportSkeletonType -q;

Use this function to either import or exclude Skeleton definitions with your
FBX file. See Skeleton Definitions As (page 74) for more information.

NOTE This command is the same as the deprecated FBXImportCharacterType
command.

FBXImportSkins

FBXImportSkins -v [truelfalse];
FBXImportSkins -q;
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Use this function to import or exclude skin deformations from your FBX file.
See Deformed models (page 74) for more information.

FBXImportUnlockNormals

FBXImportUnlockNormals -v truelfalse;
FBXImportUnlockNormals -q;

Overrides the default Maya locking of normals.

True

Recomputes the normals on the objects using Maya internal algorithms.

FBXImportUpAxis

FBXImportUpAxis [ylz];
FBXImportUpAxis -q;

This command is the script version of the Axis conversion option in the
FBX Importer but is not available in the plug-in Ul See Axis conversion
(page 81).

FBXGetTakeComment

FBXGetTakeComment [index];

Returns the comment attached to the take at the specified index in the take
array. This command uses the file stored in the file buffer.

You can load a file into the file buffer with the FBXRead command.

NOTE

You must enter numbers from 1 to the number of takes contained in the file
otherwise the script returns the message: No such take. The Maya FBX plug-in
considers any number of takes greater than the amount of takes in the file,
negative values, or zero, to be invalid.
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FBXGetTakeCount

FBXGetTakeCount;
Returns the number of takes saved in the file stored in the file buffer.

You can load a file into the file buffer with the FBXRead command.

NOTE

If Maya FBX plug-in does not find any takes in the file, the script returns a
value of 0.

FBXGetTakelndex

FBXGetTakeIndex [take name];

Returns the index of the first take named as the parameter in the take array.
This command uses the file stored in the file buffer.

You can load a file into the file buffer with the FBXRead command.

NOTE

If [take name] does not contain a valid name, the script returns the message:
No such take.

FBXGetTakeLocalTimeSpan

FBXGetTakeLocalTimeSpan [index];

Returns the local start and stop time of the take at the specified index in the
take array. This command uses the file stored in the file buffer.

You can load a file into the file buffer with the FBXRead command.

NOTE

You must enter numbers from 1 to the number of takes contained in the file,
otherwise the script returns the message: No such take. The Maya FBX plug-in
considers any number of takes greater than the amount of takes in the file,
negative values, or zero, to be invalid.
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FBXGetTakeName

FBXGetTakeName [index];

Returns the name of the take in the take array's specified index. This command
uses the file stored in the file buffer.

You can load a file into the file buffer with the FBXRead command.

NOTE

You must enter numbers from 1 to the number of takes contained in the file
otherwise the script returns the message: No such take. The Maya FBX plug-in
considers any number of takes greater than the amount of takes in the file,
negative values, or zero, to be invalid.

FBXGetTakeReferenceTimeSpan

FBXGetTakeReferenceTimeSpan [index];

Returns the reference start and stop times of the take at the specified index
in the take array. This command uses the file stored in the file buffer.

You can load a file into the file buffer with the FBXRead command.

NOTE

You must enter numbers from 1 to the number of takes contained in the file,
otherwise the script returns the message: No such take. The Maya FBX plug-in
considers any number of takes greater than the amount of takes in the file,
negative values, or zero, to be invalid.

FBXLoadExportPresetFile

FBXLoadExportPresetFile -f [filepath];

Sets the export preset file path.

FBXLoadlmportPresetFile

FBXLoadImportPresetFile -f [filepath];
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This command lets you set the import preset file path.

You can use this to load the MotionBuilder Import presets without knowing
their file path.

For example: FBXLoadMBImportPresetFile; loads
"C:\maya2013\bin\plug-ins\FBX\Presets\2013.0\import\Autodesk
MotionBuilder.fbximportpreset" (The path may be different on your machine.)

FBXLoadMBExportPresetFile

This command loads the MotionBuilder presets provided with each release.

You can use this to load the MotionBuilder Import/Export presets without
knowing their file path.

For example: FBXLoadMBExportPresetFile; loads
"C:\maya2013\bin\plug-ins\FBX\Presets\2013.0\export\Autodesk
MotionBuilder.fbxexportpreset" (The path may be different on your
machine.)

FBXLoadMBImportPresetFile

This command loads the MotionBuilder presets provided with each release.

You can use this to load the MotionBuilder Import/Export presets without
knowing their file path.

For example: FBXLoadMBImportPresetFile; loads
"C:\maya2013\bin\plug-ins\FBX\Presets\2013.0\import\Autodesk
MotionBuilder.fbximportpreset™ and FBXLoadMBExportPresetFile; loads
"C:\maya2013\bin\plug-ins\FBX\Presets\2013.0\export\Autodesk
MotionBuilder.fbxexportpreset" (The path may be different on your
machine.)

FBXPopSettings

FBXPopSettings;

This setting loads all settings that were saved by the Pop script; it preserves
the current state of the settings when you perform a One-Click operation.
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FBXPushSettings

FBXPushSettings;

This setting saves all I/OSettings. Use FBXPushSettings to preserve the current
state of the settings when you perform a One-Click operation.

FBXRead

FBXRead -f [filename];

Reads the specified FBX file without importing anything into Maya. The file
is instead stored in a buffer. This command is used for take querying.

Once read or imported, use the commands FBXGetTakeCount,
FBXGetTakeName, FBXGetTakeIndex for take querying.

NOTE

The file you are reading must match an existing file name, otherwise the file
in the buffer is destroyed if you attempt to read or import a non-existent file.

FBXResetimport

FBXResetImport;

This command restores the default values of the FBX Importer and loads
settings specified in the Autodesk Media & Entertainment import preset , as
in Ul See import Presets (page 64) for more information.

FBXResetExport

FBXResetExport;

This command restores the default values of the FBX Exporter and loads
settings specified in the Autodesk Media & Entertainment export preset. See
Preset options (page 35) for more information.
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FBXResamplingRate

FBXResamplingRate -v [float];
FBXResamplingRate -q;

Sets the rate at which the exporter produces keyframes when it needs to
resample data.

Resampling is needed when the interpolation of the Maya animation curve
cannot be perfectly represented by curves in MotionBuilder.
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Troubleshooting and
Limitations

Because the Maya FBX plug-in supports so many software packages, it is inevitable
that occasional problems will occur or some details will not yet have attained perfect
support.

Occasionally, the default settings of plug-in do not respect a particular workflow, or
the conversion process creates conflicts between two packages with similar but not
identical functions. Sometimes a file is exported correctly but becomes inexplicably
larger, or the assets in the file are no longer in the same location as they were before
conversion.

This section contains a troubleshooting guide for problems with the import or export
process as well as contains details on known limitations for the Maya FBX plug-in.

Troubleshooting

This section contains descriptions of some advanced problems, explains why
they occur, and if available, offers workarounds.

If none of the topics in the Troubleshooting or Limitations section help you,
search the FBX Forums. The forums contain ongoing discussion about the Maya
FBX plug-in, as well as an e-mail address where you can contact support.

Where did the FBX Ul go?

If you import or export FBX files and the FBX Importer or Exporter window
does not appear, it could be because the Maya FBX plug-in cannot find MEL
scripts that are included by the FBX installer. The scripts are automatically
installed to the following path:

119


http://area.autodesk.com/forum/autodesk-fbx/

<Maya version>/scripts/FBX

If they are deleted, the FBX user interface no longer appears. You can restore
these files which will bring back the interface if you reinstall the plug-in.

Maya Default Ul

If you are using the Maya Default UI setting, the FBX options to the right
of the file browser area may be collapsed. Drag the splitter bar at the right side
to the center of the dialog box to expand the FBX options.

Where are my textures?

Textures disappear from files when if you move or delete any texture from
the relative and absolute paths of the associated media files location. This can
happen when you give the FBX file to someone using a different computer
who does not have that texture in that your directory on the your computer
drive.

Use the Embed Media option to make the FBX plug-in includes (embeds)
the associated media (textures, for example) within the FBX file. The plug-in
then extracts the media to an .fbm folder at import. The plug-in copies the
embedded media to a <fileName>.tbm folder in the same location as the FBX
file and is named after the FBX file.

NOTE

When you activate Embed Media, the media is contained within the FBX
file itself, and this has an impact on file size. It is good practice to use this
option only when you transport an FBX file to a location where the original
media source is no longer accessible by the receiver.

If you disable the Embed Media option, the FBX plug-in stores the relative
and absolute paths of the associated media files at export time. This causes
problems if, for some reason, the path is no longer accessible. Make sure that
the associated media is accessible to ensure the proper import of these media
files.

Why should | embed media?

If you export a file to FBX and do not activate the Embed Media option, no
problems occur if you open the file on the same computer and all the images
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used in the scene are in the same locations that they were when the file was
exported.

It is a good practice to embed media when you are going to give the FBX file
to another person. It is also a good practice to embed when you use FBX for
storing assets, as you may eventually delete the reference images or move all
the files to another drive or computer with different paths.

NOTE

If you export your file in ASCII format in FBX versions 2010 and earlier, no
textures are embedded.

Embed Media is active, but I still do not see my textures

In previous versions of the Maya FBX plug-in, when you saved an FBX file
with the Embed Media option activated, the embedded files were extracted
to a folder in the same location as the FBX file. If you did not have write
permission for the folder, then the media files were not extracted. You can
experience this lack of write permission when you work over a network.

With the current version of the Maya FBX plug-in, if you do not have write
permission for the folder creation, the media files are sent to a temp folder
instead.

NOTE

If you export your file in ASCII format using FBX versions 2010 and earlier,
no textures can be embedded.

Where are my MotionBuilder layers?

The Maya FBX plug-in lets you import animation layers without baking them.
Otherwise, the animation is baked into the base animation layer.
To retain animation layers as separate layers in Maya:

When you import an FBX file, disable the Bake Animation Layers option
in the Maya FBX importer. See Bake animation layers (page 70).

If the option is active, the plug-in automatically bakes the animation layers
during the import process.
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Why are my cameras inconsistent?

If you import a Maya camera into 3ds Max using a Fit Resolution Gate
setting of Vertical or Fill, the results will differ.

For better support between Maya cameras in 3ds Max, set the Fit Resolution
Gate setting to Horizontal, rather than Vertical or the default, Fill.

NOTE

You can import 3ds Max cameras into Maya with no difficulty; Maya renders
the same result.

Why are my normals locked on import?

If you import non-deformed geometry, the normals are locked on import to
Maya. These locked normals can create problems when you deform the
geometry in Maya.

For example, if you import blend shape targets that were created in 3ds Max
and then export them to FBX, they import into Maya with their normals
locked.

You can address this problem if you unlock the deformed object's normals in
Maya. To unlock the normals, import the geometry into Maya and then select
Normals > Unlock normals.

What causes this?

If you import non-deformed geometry the normals are locked when you
import it to Maya.

When normals are locked by Maya, they will not move with the geometry
when you deform the imported objects. If you do not unlock these normals,
you may experience shading issues when you apply modifiers such as skin or
blendshapes.
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Why does the plug-in not match the help docu-
mentation?

If you find something in your version of the Maya FBX plug-in that does not
appear in the documentation, consult the readme file that accompanied the
plug-in. The readme will contain last-minute changes to the software that are
not reflected in the documentation.

It is also possible that your version of the Maya FBX plug-in may not be the
most recent version. It is a good practice to check for updates, as each
subsequent Maya FBX Plug-in version has enhanced functionality, and is
available free. See Web updates (page 27) for instructions on how to verify
that your plug-in version is the latest.

NOTE

You can also use the comment link at the bottom of the online help to send
a comment to the FBX team.

The plug-in does not run

Plug-ins run only on the version of Maya for which they are created; verify
that the version of the Maya FBX plug-in that you are installing is appropriate
for the version of Maya you are running.

Why do my MotionBuilder edges look different?

Older versions of MotionBuilder (versions 2010 and earlier) do not support
hard/soft edge normals and can result in shading issues in MotionBuilder.

If you are using an earlier version of MotionBuilder and this problem occurs,
activate the Split per-vertex normals option. When you activate this
option, geometry vertex normals are split based on edge continuity. Vertex
normals determine the visual smoothing between polygon faces. They reflect
how Maya renders the polygons in smooth shaded mode.

Why would I use this?

This option lets you keep the same hard/soft edge look that you get from Maya
in MotionBuilder.
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Do not use this option if you do not require hard edges in MotionBuilder,
since this operation duplicates vertex information and converts the geometry
itself. You can use the Combine per-vertex Normals option in the FBX
Importer to perform the inverse operation, but this may result in incorrect
UV texture maps, see the note that follows this entry.

If you are not using a merge-back workflow (merging FBX into existing scene)
using this option may result in incorrect UV mapping when reimporting the
FBX file into Maya. Import your FBX file into to your original Maya scene, to
avoid geometry UV issues with split geometry.

Exporting with the Split per-vertex Normals option disabled produces the
following result in MotionBuilder:

Exporting with the Split per-vertex Normals option activated produces
the following result in MotionBuilder:

NOTE

Using this option alters UV maps applied to geometry permanently. The UVs
are then properly reassigned to the newly split geometry. When you import
this geometry into an empty Maya scene, there is a UV limitation where using
Combine per-vertex Normals in the FBX Importer might result in
incorrect UV assignments.
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Why are my sets empty?

This is due to a limitation. See Selection sets (page 128) for more information.

Why Does My Mudbox Model Render Incor-
rectly?

If you are exporting a mesh that has been used as the source in a texture map
extraction (for example, if you used this model as the source to extract a
displacement map), be aware that any extracted texture maps are automatically
exported with your model.

This can result in unexpected deformation when you import the model into
another application, as the texture maps are automatically assigned to the
model on import. If you experience this issue, you can remove any unwanted
texture map from the associated channel (such as the displacement or bump
channel) after importing the model.

Limitations

The following section contains a list of known limitations for this version of
the Maya FBX plug-in. If you have problems with the plug-in that are not
listed here, refer to the Troubleshooting (page 119) section.

m Preset Bake Animation settings (page 126)
m  Non-orthogonal matrices (page 126)

m  Cannot cancel file overwrite (page 127)

m  Cluster import (page 127)

m  Scale compensation (page 127)

m  Selection sets (page 128)

m Instanced geometry (page 128)
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Tangents and Binormals

There is a known FBX limitation where exported binormal and/or tangent
information does not appear, even if you activate the Export [Idclude [
Geometry [Tdngents and Binormals option.

The Tangents and Binormals option only works on meshes that have only
triangle polygons, so you may need to triangulate the mesh before activating
this option.

Preset Bake Animation settings

You cannot save Bake Animation settings (Start/End/Step values) in
Preset files. If you created a preset that had specific settings for the Bake
Animations values, these values will not be used the next time you load the
preset. Instead, the FBX plug-in will always default to the values set for the
scene's timeline.

For example, if the animation in the scene is 102 frames long, the Start value
will be 1, the End value will be 102, and the Step value will be 1, regardless
of what is values you may have stored in the preset for this setting.

Non-orthogonal matrices

“Orthogonal” is a term used to describe two vectors that are perpendicular (at
90 degrees) to each other. In 3D space, when the X, Y, or Z-axes are not
perpendicular, they are considered “non-orthogonal” and the FBX plug-in
does not support their representation as a matrix. For example, a
non-orthogonal set of axes can occur when you use rotation and scaling to
skew an object.

Because the FBX plug-in assumes that there is always a 90 degree angle between
the X, Y, and Z axes, it can support only orthogonal matrices. Any transformed
axes that have non-orthogonal TRS matrices are ignored by the FBX plug-in,
so it does not import or export effects created when axes are not orthographic.
Because of this, any non-orthogonal effect (such as skewing) is lost.

This can cause problems even when you have transformation data that has
been inherited from other objects, for example, scaling via a parent object
where the result is a non-orthogonal local TRS matrix.
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Cannot cancel file overwrite

In previous versions of the Maya Ul (before version 2011), as well as the
"Classic" OS Native Ul that is still available in Maya 2013, if you want to
overwrite an existing file, the Overwrite dialog box appears. If you select Yes,
and then cancel the export in the FBX exporter window that appears, the FBX
file that was to be overwritten is instead deleted.

This is not a problem if you use the Maya 2013 default UI while exporting to
FBX because the file browser and exporter options now appear in the same
window. If you use the Maya Default UI to export to FBX, you can cancel
the export operation without deleting the original FBX file. See Switching the
FBX UI (page 20).

Cluster import

To import clusters correctly into Maya, deactivate the Deforming elements to
joints (page 73) option. Otherwise their cluster pivots do not import correctly.

Scale compensation

There is no limitation for the scale compensate setting in the Maya FBX plug-in
itself.

However, there is a limitation in 3ds Max. If you modify the scale of joints
that are parents of other joints in Maya, a conversion is performed that
compensates for the scaling behavior that is not found in 3ds Max. This is
done by animating the scale of the child joint. This conversion maintains the
visual fidelity of Maya animation in 3ds Max.

What does Scale Compensate do?

If you scale a parent joint in Maya using scale compensation, it creates an
offset for a child joint rather than scaling it.

But if you do the same thing in 3ds Max, the child scales and creates no offsets.
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Selection sets

A known limitation exists where sets that contain NURBS Sub-components,
such as Isoparm, Control Vertex, or Surface Patch, are not retained in
sets and will not be exported.

Instanced geometry

A limitation exists where FBX does not support instanced geometries that
have materials that differ from the original geometry object.

NOTE While instanced geometries are supported, materials differences are not.
For example, if two instances of a geometry have colors A (original object color)
and B, once exported to FBX, both will share color A
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